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Welcome to the 80SJNB jitter, noise, BER, serial data link, PAM4, and TDECQ analysis software

Welcome to the 80SJNB jitter, noise, BER, serial data link, PAM4, and
TDECQ analysis software
The 80SJNB analysis software enhances the capabilities of the DSA8300 Digital Serial Analyzer.
Several versions are available: 80SJNB Essentials, 80SJNB Advanced with Serial Data Link Analysis,
80SJNB-PAM4 with advanced PAM4 signaling analysis, and 80SJNB with TDECQ (Transmitter and
Dispersion Eye Closure Quaternary for PAM4) measurement that is now part of the PAM4 package.
A dedicated Acquisition Only mode is available to provide data for post processing, such as for
manufacturing processing.

80SJNB Essentials provides the following features:
Perform advanced jitter and noise analysis (RJ, DDJ, PJ, DCD, BUJ, TJ@BER, and RN, DDN(high)
and DDN(low), BUN, TN@BER, vertical and horizontal eye opening at BER)
Perform mask testing on PDF eyes and BER contours
Acquire complete pattern waveform at 100, 40, 20, or 10 Samples/UI
Perform random and deterministic jitter analysis including BER estimation
Isolate and measure crosstalk in form of bounded uncorrelated jitter (BUJ)
Display results graphically including histograms, spectra, and bathtub curves
Display 2-D eye diagrams (correlated eye, probability density function (PDF) eye, and bit error
ratio (BER) eye)
Save complete acquisition results to a data file
Analyze jitter, noise, and BER in the presence of spread spectrum clocking (SSC)
80SJNB Advanced includes everything in Essentials and adds:
Signal path emulation, allowing you to emulate the environment your signal encounters from the
transmitter to the receiver. Feature include:
Supports CTLE, FFE, and DFE equalization
Allows user-defined arbitrary filters (use for de-embedding, CTLE Transmitter equalization, and
other applications)
Supports channel emulation (TDR/TDT and S-parameter based channel descriptions)
Other features commonly known as SDLA (Serial Data Link Analysis)
80SJNB PAM4 includes everything in Advanced and adds:
Comprehensive jitter, noise and BER analysis for each eye
Global PAM4 signal characterization measurements
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Welcome to the 80SJNB jitter, noise, BER, serial data link, PAM4, and TDECQ analysis software
Full signal path emulation support
Rise/Fall measurements

80SJNB TDECQ (Transmitter and Dispersion Eye Closure for PAM4) includes everything in PAM4
and adds:
Standard IEEE TDECQ measurements
Plots with annotations for the results
80SJNB provides bandwidth enhancement (BWE) capabilities for the high bandwidth, low noise, optical
modules the DSA8300 supports. Accuracy is enhanced by allowing you to:
Chose to apply the BWE filters
Create BWE filters from S-parameters that characterize the target acquisition modules
Load BWE filters if previously generated
What do you want to do?
Read the product description (see page 7).
Go to Operating Basics (see page 13).
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Related documentation

Related documentation
The following links contain other information on how to operate the oscilloscope and applications:
GPIB Information (see page 3)
Types of Help Information (see page 4)

GPIB information
For information on how to operate the oscilloscope and use the application-specific GPIB commands,
refer to the following items:
The programmers guide for your oscilloscope can provide details on how to use GPIB commands
to control the oscilloscope.
The 80SJNB remote control functions (see page 103)

Conventions
Help topics use the following conventions:
The terms “80SJNB application” or “application” refer to the 80SJNB Jitter, Noise and BER Analysis
software.
The term “oscilloscope” or “TekScope” refers to the product on which this application runs.
The term “select” is a generic term that applies to the two methods of choosing an option: with
a mouse or with the Touch Screen.
The term “DUT” is an abbreviation for Device Under Test.
When steps require a sequence of selections using the application interface, the “>” delimiter marks
each transition between a menu and an option. For example, one of the steps to recall a setup file
would appear as File > Recall Settings.

80SJNB Printable Application Help
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Types of application help information

Types of application help information
The application help contains the following topics:
Getting Started topics briefly describes the application and its requirements.
Operating Basics topics cover basic operating principles of the application. The sequence of topics
reflects the steps you perform to operate the application.
Parameters topics cover the Analysis and Configuration default settings.
Application Examples topics show how to use jitter measurements to identify a problem with a
waveform. This should give you ideas on how to solve your own measurement problems.
GPIB Command Syntax topics contain a list of arguments and values that you can use with the remote
commands and their associated parameters.

See also:
Using Help (see page 4)

Application help use
Application help has many advantages over a printed manual because of advanced search capabilities.
The main (opening) Help screen shows a series of book icons and three tabs along the top menu, each of
which offers a unique mode of assistance:
Contents tab - organizes the Help into book-like sections. Select a book icon to open a section;
select any of the topics listed under the book.
Index tab - enables you to scroll a list of alphabetical keywords. Select the topic of interest to display
the corresponding help page.
Search tab - enables you to search the entire help contents for keywords. Select the topic of interest to
display the corresponding help page. Search results do not include text contained within illustrations
or screen shots.
NOTE. Blue-underlined text indicates a hyperlink to another topic. For example, select the blue text to
jump to the topic on Feedback to Tektronix. (see page 5)
TIP. When you use a mouse, the normal cursor changes to a link cursor when over an active hyperlink.

4
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Feedback

Feedback
Tektronix values your feedback on our products. To help us serve you better, please send us suggestions,
ideas, or other comments you may have about your application or oscilloscope. Send your feedback to
techsupport@tektronix.
Please be as specific as possible and include the following information:

General information
Oscilloscope model number, firmware version number, and hardware/software options, if any.
Module and probe configuration. Include model numbers and the channel/slot location.
Serial data standard.
Signaling rate.
Pattern type and length.
Your name, company, mailing address, phone number, FAX number.
NOTE. Please indicate if you would like Tektronix to contact you regarding your suggestion or comments.

Application-specific information
80SJNB Software version number.
Description of the problem such that technical support can duplicate the problem.
If possible, save the oscilloscope waveform file as a .wfm file.
If possible, save the 80SJNB data to a .mat file (File > Save Data).
If possible, save the 80SJNB and oscilloscope settings to a .stp file (File > Save Settings).
Once you have gathered this information, contact technical support by phone or through email. If using
email, be sure to enter “80SJNB Problem” in the subject line, and attach the .stp and .wfm files.
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Product description

Product description
The 80SJNB software application enhances the capabilities of the DSA8300 Digital Serial Analyzer by
providing Jitter, Noise, and BER analysis (Essentials) and features for de-embedding the fixture, channel
emulation, and FFE/DFE equalizer support (Advanced). The PAM4 option adds comprehensive analysis
of PAM4 signals to 80SJNB Advanced including the TDECQ measurements.
You can use this application to do the following tasks:
Jitter and noise analysis from DC to 400 Gb/s and beyond
Jitter and noise separation (see the Importance of Jitter and Noise Separation (see page 9))
Perform random and deterministic jitter and noise analysis, and TJ@BER, TN@BER and BER
estimation
Isolate jitter and noise due to crosstalk, and make random and deterministic estimations in the
presence of crosstalk
Show results as numeric and graphical displays
Display 2-D eye diagrams (Correlated Eye, Probability Density Function (PDF) Eye, and Bit Error
Rate (BER) Eye) for both NRZ and PAM4 signals
Perform mask testing on PDF eyes and BER contours
Support for CTLE, FFE and DFE equalization
Perform TDECQ (Transmitter and Dispersion Eye Closure for PAM4)
Allow user-defined linear arbitrary filters
Support for Channel Emulation (from TDR/TDT and S-parameter based channel descriptions)
Analyze jitter, noise, and BER in the presence of Spread Spectrum Clocking (SSC)
Save results to a PDF file
Save and recall instrument setups

See also:
Review Requirements and Restrictions (see page 7)

Requirements and restrictions
Operating system. Microsoft Windows 7 Ultimate (32 bit) operating system operating on the DSA8300
Digital Serial Analyzer oscilloscope.
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ADVTRIG option. 80SJNB requires the Advanced Trigger option (ADVTRIG). Contact Tektronix about
purchasing this option.
82A04/82A04B Phase Reference module. For acquisition in the presence of Spread Spectrum Clocking
(SSC), this application requires that the sampling oscilloscope be equipped with a Tektronix 82A04 or
82A04B Phase Reference module. The 82A04/4B also lowers the jitter floor to 100 fs. Contact Tektronix
about purchasing the module for your sampling oscilloscope.
Keyboard and mouse. You must use a keyboard to enter names for some save and export operations. A
mouse is not required but simplifies screen selections.

Accessories
There are no standard accessories for this product. Refer to the product data sheet available on the
Tektronix website for information on optional accessories relevant to your application.
A second monitor connected to the TekScope is recommended for simultaneous viewing of the oscilloscope
screen and the 80SJNB application screen.
Refer to Requirements and Restrictions (see page 7) for additional items required to use the 80SJNB
application.

Connecting to a device under test (DUT)
You can use any compatible probe or cable interface to connect your DUT and the instrument.
WARNING. To avoid electric shock, remove power from the DUT before attaching probes. Do not touch
exposed conductors except with the properly rated probe tips. Refer to the probe manual for proper use.
Refer to the General Safety Summary in your oscilloscope manual.

See also:
Deskewing Probes and Channels (see page 9)
An Application Example (see page 88)
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Deskewing probes and channels
To be sure of accurate results for two-channel measurements, it is important to first deskew the probes
or cables and oscilloscope channels before you take measurements.
NOTE. Deskewing is performed from the TekScope application, not from the 80SJNB application. Refer to
the DSA8300 Quick Start User Manual and the DSA8300 Help system for information and procedures for
deskewing probes and channels.

The importance of jitter and noise separation
Jitter is an important characteristic to analyze for serial data links, but the analysis should not stop at just
jitter. To properly evaluate a data link, it is necessary to analyze both jitter and noise.
Two components need to be added to the traditional jitter analysis:
The noise/vertical eye closure should be considered similar to that of jitter/horizontal eye closure.
Jitter measurements based on the threshold crossing of a finite-speed transition should include vertical
noise influence.
Noise measurements and jitter and noise separation and reconciliation is performed on all 4 levels of
a PAM4 signal.
Depending on the magnitude of the vertical noise and the transient response of the transmitter and
transmission channel, the magnitude of this influence can vary widely. Ultimately the jitter and noise
analysis allows for accurate BER projections for the targeted communication link.
Go to www.tek.com/jitter for additional jitter and timing analysis information.
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Jitter and noise separation methods

Bit error rates (BER) of a serial data stream are impacted by both jitter and noise. An accurate
decomposition of jitter and noise in the sources of impairments is critical to correctly estimate the signal
path behavior at larger BER. The jitter and noise maps are critical to help debugging the devices under test.
Since jitter and noise analysis follows a similar path, this discussion covers just the jitter decomposition.
The basic separation of jitter in data-dependent and uncorrelated elements is accomplished by two targeted
acquisition steps:
Correlated Acquisition Step: the application filters a high resolution acquisition of the full pattern
to eliminate the uncorrelated elements. The analysis of the filtered pattern yields the data dependent
characteristics, such as Data Dependent Jitter (DDJ) and Duty Cycle Distortion (DCD).
Uncorrelated Acquisition Step: the uncorrelated elements of jitter are isolated by acquiring on well
defined single spots in the pattern, thus eliminating the dependency on the pattern itself. The data
acquired in the uncorrelated acquisition step is then further analyzed to isolate random unbounded
components from the bounded deterministic components. This extended analysis is critical to help
predict long term behavior of the DUT.
Historically only spectral separation was used for separation (available still as the Spectral (Legacy)
analysis method). This method improperly qualifies certain complex bounded uncorrelated components as
unbounded, which inflates the random jitter (RJ) measurement result.
Spectral separation with isolation of bounded uncorrelated jitter (Spectral + BUJ) works by also
analyzing the cumulative distribution function (CDF) of the uncorrelated non periodic jitter data. In
the spectral separation of Periodic Jitter from the Random Jitter, the distinct spectral lines are removed
from the frequency domain representation of the global uncorrelated jitter data to quantify the periodic
jitter components, PJ. In the legacy method, the spectral method evaluated the remaining spectral data
as Random Jitter (RJ).

10
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The presence of complex bounded uncorrelated impairments (for example, originating from crosstalk)
requires significant additional steps to isolate the bounded, uncorrelated jitter (BUJ) from the periodic jitter
(PJ), nonperiodic jitter (NPJ), and random jitter (RJ) components.
The CDF analysis is performed in two steps: before and after the spectral separation that identifies the
periodic spectral components. The first analysis step yields the total bounded uncorrelated jitter, while the
second analysis step yields the nonperiodic elements, and finally the random jitter components.
A parallel analysis track develops the noise map, and a combination of the two analysis tracks characterizes
the behavior of the link in terms of bit error ratio (BER).
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About operating basics

About operating basics
These topics cover the following tasks:
Navigating the user interface (see page 24)
User interface information (see page 22)
Using oscilloscope functions (see page 21)
Setting up the application (see page 28)
Viewing the measurement results as plots (see page 22)
Exporting Plot Files (see page 74)
Saving (see page 70) and recalling (see page 70) setup files
Saving (see page 71) and recalling (see page 71) data files
What do you want to do?
Start the 80SJNB Application (see page 13)

See also:
File Name Extensions (see page 17)
File Menus (see page 18)

Starting the 80SJNB application
There are several ways to start the 80SJNB application.
If the TekScope application is minimized, double-click the 80SJNB application icon on the Windows
desktop to start the 80SJNB application.

If the TekScope application is running and open, select Applications > 80SJNB or 80SJNB
Advanced.

In Windows, select Start > All Programs > Tektronix Applications > 80SJNB > 80SJNB.exe.

80SJNB Printable Application Help
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Returning to the oscilloscope application

TIP. With a second monitor connected to the TekScope, you can move the 80SJNB application display to
the second monitor, allowing you to view both screens at the same time.

See also:
Returning to the 80SJNB Application (see page 15)
Returning to the Oscilloscope Application (see page 14)

Returning to the oscilloscope application
The 80SJNB application fills the entire screen and hides the TekScope application. To return to the
TekScope display, click the Back to Scope button

in the toolbar.

You can also minimize the 80SJNB application or exit the 80SJNB application entirely.

See also:
Minimizing and Maximizing the Application (see page 15)
Exiting the Application (see page 16)
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Returning to the 80SJNB application

Returning to the 80SJNB application
The TekScope application fills the entire screen. If the 80SJNB application is already running but the
TekScope application is displayed on top, bring the 80SJNB application to the front using one of the
following methods.
Click the App button on the TekScope toolbar.

Select Applications > Switch to 80SJNB.

TIP. If you have a keyboard attached, you can switch between running applications by pressing the Alt
+ Tab keys.

Minimizing and maximizing the application window
To minimize the application to the Windows task bar, select the
menu bar.

command button in the application

To maximize the application, select the minimized application from the Windows task bar. Alternately, if
you have a keyboard attached, switch between displayed applications by pressing Alt + Tab keys.

80SJNB Printable Application Help
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Exiting the application
To exit the application, select File > Exit or the

command button in the application menu bar.

Software and file installation directory
The 80SJNB software is installed in the following directory:
C:\Program Files\TekApplications\80SJNB

Save and recall directory
The directory structure for saving and recalling setup and data files and exporting data is:
C:\Users\<user name>\Documents
The default user name is:
Tek_Local_Admin
Standard masks are installed at:
C:\Users\Public\Documents\Tektronix\Masks

See also:
File Name Extensions (see page 17)
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File name extensions
Extension

Description

.bmp
.csv

File that uses a bitmap format

.flt

80SJNB application filter file

.jpg

File that uses a joint photographic experts group format

.mat

File that uses native MATLAB binary format to store data acquired by 80SJNB

.msk
.png

Tektronix mask file (Mask file structure (see page 99))

.s1p
.s2p
.s4p

Files that define 1-port, 2-port, and 4-port frequency domain S-parameters

.stp

80SJNB application setup file

.tap

80SJNB application equalization tap file

.txt

File that uses an ASCII format

.wfm

File that defines time domain waveforms or a frequency domain 1-port S-parameter (created
by IConnect) for channel emulation
80SJNB accepts both DSA8300 and IConnect .wfm files

File that uses a comma separated value format

File that uses a portable network graphics format

xxx
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File menu
The File menu lets you save and recall application setups, data files, and recently accessed files.
CAUTION. Do not edit a setup file or recall a file that was not generated by the application.

Menu item

Description

Save Settings

Saves the current application settings in a .stp file

Recall Settings

Browse to select an application setup (.stp) file to recall; restores the application and oscilloscope
to the values saved in the setup file

Save Data

Saves the current acquired data in a .mat file for later analysis
Saving is disabled if there is no acquired data to save or an acquisition is in process

Recall Data

Recall a saved data file for analysis
All plots and results are based on the recalled data
Recalling is disabled if an acquisition is in process

Export Results

Exports jitter and noise analysis results to a .csv format user specified file.
Signal attributes and analysis configuration parameters are added to the report to qualify the
measurement results.

Export Waveform

Acquired exports the raw acquired pattern before processing of the data
Correlated exports the acquired waveform after filtering out the uncorrelated components

Print

Prints the displayed plots and all numeric results

Print to File

Print the displayed plots and all numeric results to a .pdf file

Exit

Exits the application

xxx

See also:
About the 80SJNB Tool Bar (see page 25)
Saving a Setup File (see page 70)
Recalling a Saved Setup File (see page 70)
Saving a Data File (see page 71)
Recalling a Saved Data File (see page 71)
About Exporting Plot Files (see page 74)
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View menu
The View menu lets you configure the display of plots and/or numerical data. The menu contents depend
on the current acquisition mode (NRZ, PAM4, or TDECQ).

NRZ acquisition mode View menu
Menu item

Description

1-up

Displays a single plot on the screen

2-up

Displays two plots on the screen

4-up

Displays the maximum of four plots on the screen

Plots Only

Hides all numeric data, expands the displayed plot(s) to fill the screen

Numeric Summary

Displays the plots and a summary of the analysis results

Full Numeric Results

Displays the plots and the full results table (JNB or Mask)

Global Results

Displays a summary of Jitter and Noise measurements, Rise/Fall, and level measurements

JNB Results

Displays the JNB Results tab, which contains the JNB results table

Mask Results

Displays the Mask Results tab, which contains the Mask test results table

xxx

PAM4 acquisition mode View menu
Menu item

Description

1-up

Displays a single plot on the screen

2-up

Displays two plots on the screen

4-up

Displays the maximum of four plots on the screen

Plots Only

Hides all numeric data, expands the displayed plot(s) to fill the screen

Numeric Summary

Displays the plots and a summary of the analysis results

Full Numeric Results

Displays the plots and the full results table (JNB or Mask)

Global Results

Displays the global PAM4 results tab containing global and summary information

JNB Results: Eye0

Displays the JNB Results tab for eye 0, which contains the eye 0 results table

JNB Results: Eye1

Displays the JNB Results tab for eye 1, which contains the eye 1 results table

JNB Results: Eye2

Displays the JNB Results tab for eye 2, which contains the eye 2 results table

Mask Results

Displays the Mask Results tab, which contains the Mask test results table

Rise/Fall
Measurements

Displays the Rise/Fall measurements and their statistical analysis

xxx
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TDECQ acquisition mode View menu
Menu item

Description

1-up

Displays a single plot on the screen – TDECQ

Global Results

Displays 4 measurements: TDECQ, OMA Outer, ER, and AOP

NOTE. No other display configurations are relevant when View is set to TDECQ.
xxx

See also:
About the 80SJNB Tool Bar (see page 25)

Setup menus
The Setup menus provide access to the various configuration menus.
Menu item

Description

Acquisition

Displays the Acquisition setup dialog screen to select and configure the source for measurements
and control key oscilloscope setups

Signal Path

Displays the Signal Path dialog screen to define the signal path characteristics to simulate the
actual conditions your signal may encounter

Analysis

Displays the Analysis dialog screen to change settings that affect how measurements are made
and displayed

Mask Test

Displays the Mask Test Setup dialog screen to load a mask and define the mask test parameters

Default Setup

Returns the Acquisition, Signal Path, and Analysis settings to their default values
See About Application Parameters (see page 95) to view the default settings for each configuration
menu

xxx

About the 80SJNB Tool Bar (see page 25)
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Oscilloscope settings
All relevant oscilloscope settings are accessible using the Acquisition dialog box of the 80SJNB
application.
To bring the TekScope application to the front of the display, click the Back to Scope button
or minimize the 80SJNB application. Alternately, you can use the Alt + Tab keys to switch between
applications if you have a keyboard attached.

See also:
About Configuring the Application for Analysis (see page 28)
Returning to the Application (see page 14)
Minimizing and Maximizing the Application (see page 15)

About the results
There are two ways to view analysis results: as numeric data and as graphical plots.
You can log the results data to .csv files for viewing in a spreadsheet, database, text editor or data analysis
program.
There are several results tables: Global measurements, Jitter and Noise and BER analysis for each of the
eyes (3 for PAM4), Mask analysis results, and statistical analysis for the Rise and Fall measurements.

See also:
Working with Results (see page 83)
Clearing Results (see page 22)
Exporting Plot Files (see page 74)
Exporting Results from the File Menu (see page 18)
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Clearing results
Click the Clear Data
button to remove the existing plot displays and results. You may want to clear
the data before acquiring new data or between cycles when the sequence mode is set to Free run.
NOTE. The numeric results and plot files are erased each time a new acquisition cycle is started.

About plotting
The application displays the results as plots for more comprehensive analysis. Before or after you take
measurements, you can select to display a single plot, two plots or four plots. You can select the type
of data you want to view in each plot window.

See also:
Working with Plots (see page 72)
Plot Type Definitions (see page 72)
About Working with Results (see page 83)

About the user interface
The application uses a Microsoft Windows-based user interface.
NOTE. The TekScope application is hidden when the 80SJNB application is running and not minimized.

22

80SJNB Printable Application Help

Operating basics

User interface items definitions

See also:
Starting the Application (see page 13)
Definitions of the application user interface items (see page 23)
Minimizing and Maximizing the Application (see page 15)
Exiting the Application (see page 16)

User interface items definitions
Item

Description

Area

Visual frame that encloses a set of related options

Box

Use to define an option; enter a value with the Keypad or a Multipurpose knob

Browse

Displays a window where you can look through a list of directories and files

Check box

Use to select or clear an option

Command button

Initiates an immediate action, such as the Start command button in the Control panel

Keypad

On-screen keypad that you can use to enter numeric values

Menu

All options in the application window (except the Control panel) that display when you select a
menu bar item

Menu bar

Located along the top of the application display and contains application menus

Status bar

Line located at the bottom of the application display that shows the acquisition status and the
latest Warning or Error message

Virtual keyboard

On-screen keyboard that you can use to enter alphanumeric strings, such as for file names
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Item

Description

Scroll bar

Vertical or horizontal bar at the side or bottom of a display area that you use to move around in
that area

Tool bar

Located along the top of the application display and contains application quick launch buttons

xxx

About navigation
The application provides you with several ways to display the results:
The drop-down menus available in the menu bar allows for screen configuration (one, two, or four
plots, summary or full numeric results table)
The buttons in the tool bar allow for screen configuration
The drop-down menus available in the plot display windows allow you to choose from the available
plots, and Copy, Examine, and Export plots
The status bar at the bottom of the screen contains progress information and displays error conditions
detected
Double clicking on a displayed graph opens the plot in a MATLAB window. MATLAB provides
additional display capabilities such as panning, zooming, data cursors, and 3D rotation. The Examine
button from the drop-down menu of the plot also opens the MATLAB window.

See also:
Windows User Interface (see page 22)
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About the 80SJNB Toolbar (see page 25)
About Configuring the Application for Analysis (see page 28)

About the 80SJNB tool bar
The toolbar provides quick access to the most common functions you need to configure the settings, start
the acquisition, and control the numerical and plot displays. Most tasks are also available using the
drop-down lists from the File menu bar.

Acquisition button. Use the Acquisition button to select and configure the source for
measurements and control key oscilloscope setups. Any change in the Acquisition settings clears all
the data. The Acquisition button is disabled during the acquisition and processing cycle.
Signal Path button. Use the Signal Path button to define the signal path characteristics to
simulate the actual conditions your signal may encounter. Changes made in the signal path settings
does not clear the data, only the results. The Signal Path button is disabled during the acquisition
and processing cycle.
Analysis Setup button. Use the Analysis Setup button to change settings that affect how
measurements are made and displayed. Changes made in the analysis settings does not clear the
data, only the results are updated. The Analysis Setup button is disabled during the acquisition and
processing cycle.
Mask test button. Use the Mask Test button to select a mask and configure the mask test.
Free Run On/Off button. Use the Free Run button to select the sequence mode (free run on
or off).
When OFF, the button remains blue and the acquisition and processing cycle completes one pass
over the entire pattern. Off is the default mode.
indicating that the acquisition and processing
When Free Run is ON, the button turns green
cycle repeats until stopped. The correlated components are averaged with previous data while the
uncorrelated components are accumulated for increased statistical content. At the completion of each
acquisition cycle, the plots and measurements are updated.
Free Run mode is recommended when:
There is a doubt that one acquisition cycle is enough. A change in the results indicate that additional
acquisition cycles was needed.
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The correlated waveform shows irregular disturbances. It is possible that uncorrelated information
can leak into the single-pass correlated filtering. Acquiring a larger statistical sample improves
analysis in the presence of crosstalk.
Several Standards specify the size of the data samples to be used for measurements. See the Stop on
Conditions setup in Acquisition dialog.
button. This converts the Free Run mode back to Single
To halt a Free Run cleanly, deselect the
Sequence mode, so that the acquisition stops when the cycle is complete.
Run button. Use the Run button to start the acquisition and processing cycle. Once the run
button is pressed, do not change any instrument settings. When the Run button is pressed, all current
measurement data and plot displays are cleared. During the acquisition and processing cycle, the
Signal Path, Analysis, Acquisition, and Run buttons are disabled.
During the acquisition and processing cycle, the Run button is replaced with the Pause button
.
Click Pause to interrupt the current acquisition and processing cycle. Click the button again to resume
the cycle. This is useful when the acquisition is set to Free Run, allowing you to halt the acquisition
and processing cycle so you can view and save the measurement data between cycles.
Stop button. Use the Stop button to end the acquisition and processing cycle. While in Single
Sequence mode, stopping the cycle produces no results and you must click the Start button to start a
new cycle.
Clear Data button. Use the Clear Data button to clear all results and plot displays. If Free Run
is set to ON (cumulating previous data with new), you can clear the existing results and plots during
the processing cycle, thus starting a new acquisition and processing cycle.
Plot Display buttons. Use the window pane buttons to display between 1, 2, or 4 plots.
You can change the number of plot displays at any time.
Numeric Results Display button. The results button changes the display to a complete list of
statistics. If the application is displayed on a larger screen, the numeric results display shows all the
results at once.
Back to Scope button. Use this button to bring the TekScope display to the front of the screen.

See also:
About Configuring the Application for Analysis (see page 28)
About Analysis Settings (see page 54)
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About measurement results tabs
The application shows several measurement results tabs depending on the coding of the signal (NRZ or
PAM4) being measured.

The three NRZ tabs are labeled Global, JNB Results and Mask. These tabs show the same graphs but
display different numeric results. Global results display a summary of Jitter and Noise measurements,
Rise/Fall, and level measurements. Tab JNB Results displays all jitter, noise, and BER results. The Mask
tab displays all mask results such as hit ratio, margins, and BER limit.
For PAM4 signals, six tabs are available. The Global tab displays both global PAM4 results and summary
results across all eyes. The JNB Results tab is replaced by three tabs, one per eye, labeled Eye0, Eye1 and
Eye2. Eye0 is the lowest eye. These tabs display all jitter, noise and BER results for their respective eyes.
The Rise/Fall tab displays the Rise/Fall measurements and their statistical analysis. When Fast TDECQ
mode is selected, measurements are limited to 4: TDECQ, OMA Outer, ER, and AOP.
The currently selected tab is labeled with a larger font. In addition, the three Eye tab labels are color
coded to match the figures having one graph per eye. In such figures, the yellow, green and red graphs
represent the data for eyes 0, 1 and 2, respectively.
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MATLAB user interface
The 80SJNB application includes MATLAB® plots to provide further data analysis and visualization of
the plot displays.
MATLAB provides multiple capabilities to display and annotate the plot diagrams, including:
Pan and Zoom
2D and 3D visualization
Rotation
Data Cursors
Color enhancements
MATLAB is a product distributed by MathWorks. You can view the MATLAB documentation and
tutorials on their Web site: http://www.mathworks.com

About configuring the application for analysis
The tool bar provides an Acquisition (see page 29) button
a Signal Path (see page 43) button

to configure the application to acquire data,

to set signal path conditions, an Analysis (see page 54) button

to change settings that affect how measurements are made and displayed, and a Mask test (see
page 99) button

to set the mask test parameters.

NOTE. The Acquisition settings must be set before starting an acquisition cycle. You can modify the
Signal Path and Analysis settings without the need to reacquire data. You can also change the Mask
Test without the need to reacquire data.
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to have the acquisition and processing of data run continuously (free
Use the Sequence button
run) or stop after one cycle is complete.
After setting up the application, you can select the Run button
cycle.

to start the acquisition and processing

After the acquisition and processing cycle has completed, you can view the results as numerical (see
page 83) statistics or graphically (see page 22).
A typical scenario to setup the 80SJNB application and acquire data involves the following steps:
1. Set the Source, Data Rate, and Pattern Length.
2. Select Coding: NRZ or PAM4.
3. Set the number of Samples per UI.
4. Select a Stop on Condition.
5. Set the required Count.
6. From the tool bar, select Free Run mode.
7. Issue a Run command.
8. Wait until the 80SJNB application finishes running and then stops.

See also:
About Acquiring Data (see page 29)

About acquiring data
Before making jitter and noise measurements, you need to select and configure the signal source.
Use the Acquisition button

to display the Acquisition dialog box.

In the Acquisition dialog box, select the signal source and signal coding (NRZ or PAM4), and define the
acquisition parameters. Some parameters (such as the Clock Recovery, Phase Reference Sources, and the
optical signal conditioning) are copied from the oscilloscope state.
Click the AutoSync to Selected Source button to have the 80SJNB application automatically obtain and
enter the following information from the signal applied to the channel defined as the Signal Source:
Data Pattern Rate
Data Pattern Length
Recommended Data:Clock Ratio (when Spread Spectrum Clocking (SSC) signaling is used)
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NOTE. Acquisition in the presence of SSC requires certain cabling propagation delays to be preserved.
Please contact Tektronix for an up-to-date diagram of cabling lengths.
One of the key acquisition parameters is the number of samples per unit interval. The default is 100
samples per unit interval. For higher throughput and support of longer record lengths than PRBS13, you
can optionally select 40 samples per unit interval.
The Fast TDECQ acquisition mode is optimized to return TDECQ measurements in minimum time. The
Number of Samples per UI defaults to 10, and can be set to 5. For standard SSPRQ (Short Stress Pattern
Random Quaternary), equivalent to PRBS16, the maximum number per UI is 10. For pattern lengths
shorter than PRBS13Q, this could be set to 20, 40, or 100.
The acquisition only mode (Acquire (ONLY) All Optical Channels) that when enabled, acquires all
available optical channels in the instrument at the same time. Once the acquisition is complete, save the
acquired data files for analysis at a later time. Go to File > Save Data to save the acquired data from
all channels.
NOTE. Tektronix recommends running this functionality in the oscilloscope (the equivalent menu exists in
Setup > Mode/Trigger > Pattern Sync/FrameScan Setup). The important difference is that the oscilloscope
UI/PI allows manual entry of some of the parameters of the AutoSync, which dramatically improves the
success rate of AutoSync. For example, manually entering the Data Pattern Length, and then unchecking
the pattern length item from the AutoSync search, makes the data pattern length much more likely to
succeed. Refer to the DSA8300 TekScope application help for details about the Pattern Sync settings.

See also:
Selecting the Source (see page 40)

30

80SJNB Printable Application Help

Operating basics

Selecting a Stop on Condition

Selecting the Data Pattern (see page 35)
Selecting a Stop on Condition (see page 31)
Selecting Scope Setup Recall On Exit (see page 32)
Scope Noise (see page 36)
BWE (see page 36)
Selecting the Signal Conditioning (see page 35)
Selecting the Pattern Clock (see page 39)
Selecting Clock Recovery (see page 33)
Selecting Phase Reference (see page 34)
Analysis Settings (see page 54)

Selecting a Stop on Condition
The Stop on Condition selections allow you to control the amount of data to be acquired and processed
before stopping.
NOTE. The Free Run mode has to be selected for the Stop on Conditions to be active. Use the Sequence
button

to select the continuous acquisition and processing mode.

There are four options to control the stop condition:
Never. This is the default condition. The acquisition and processing of data runs continuously until
explicitly stopped by user by clicking on the Stop button.
Acquisition cycles. Acquisition Cycles instructs the 80SJNB application to continue acquiring and
processing data until the defined number of cycles have completed. Note that changing the number of
Acquisition Cycles coerces the numbers associated with the other two options. Each acquisition cycle
includes a number of uncorrelated samples, selected by design, and a number of samples correlated with
the data pattern, which depends on the pattern length and the number of samples per data bit – which is
also selected by design.
The following equation describes the relationship between these parameters:
Total Population Limit = Acquisition Cycles * (Uncorrelated_Samples_Per_Cycle + Samples_Per_Bit
* Pattern_Length)
Uncorrelated samples. Uncorrelated Samples instructs the 80SJNB application to continue acquiring and
processing data until the data required for jitter and noise processing exceeds the specified number. The
default count is a number that represents 2 acquisition cycles.
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Total population limit. Total Population Limit instructs the 80SJNB application to continue acquiring and
processing data until the total number of samples exceeds the specified number. The default count is a
number that represents 2 acquisition cycles, and reflects the selected Pattern Length.
The actual number of acquired and processed samples is displayed in Sample Count (see below), and
corresponds to the nearest integer number of acquisition and processing cycles.

Selecting scope setup recall on exit
Acquiring data for jitter and noise analysis requires the 80SJNB application to fully control the
oscilloscope state. When this control is checked, exiting the 80SJNB application (File > Exit) restores the
oscilloscope to the state which was stored when 80SJNB application was launched.
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Selecting clock recovery
The Advanced Trigger option (ADVTRIG) that generates the pattern synchronous triggers requires a
clock source synchronous with the signal. When using a clock derived from a clock-recovery module
installed in the oscilloscope (such as optical sampling modules), use the Pattern Clock fields to select the
source module, the configuration and its frequency.

All native clock recovery modules support two different configurations: one that connects the recovered
clock from the back of the module to the internal pattern synchronous trigger generator; and, for optimal
jitter performance, the module full rate clock output can be connected to the front panel Clock/Prescale
Input.
These settings are grayed out if no modules with clock recovery are detected at application startup.
The Rate setting is limited to the capabilities of the selected module. The numeric keypad is unavailable
for use unless the module can accept USER defined rates.
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Selecting phase reference
You can use a Phase Reference module (such as the Tektronix 82A04B) to reduce the trigger jitter of the
signal source, thus increasing the jitter measurement accuracy. If analyzing a signal using Spread Spectrum
Clocking (SSC), a Phase Reference module is required.
If using a Phase Reference module, set the channel source and the frequency of the applied clock.
These settings are grayed out if a Phase Reference module is not detected at application startup. If a Phase
Reference module is detected, you have the option to not use the module by selecting None as the Source.
TIP. Selecting a Phase Reference module dramatically improves the accuracy of DDJ (Data Dependent
Jitter) and the correlated waveforms. However, the throughput is lowered in this mode.

NOTE. When using a recalled data file, the Phase Reference Frequency field is updated to indicate the
frequency when the data was acquired. The Source field remains unchanged regardless if phase reference
was used when the recalled data file was created.
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Selecting the data pattern
Defining the Data Pattern requires that you define both the data rate of the signal source and the pattern
length in bits. You can choose the data rate from a predefined set of lengths or enter a value with the
numeric keypad.
NOTE. Selecting a data rate that does not match the communication standard that is set in the instrument’s
Horizontal Communication Standard setting dialog box causes the oscilloscope setting to change to User.
When selecting the pattern length, only the length is important. The precise bit sequence is unimportant
if it is repetitive.
To analyze a clock pattern, select a 2 bits pattern (or a multiple). The analysis is performed on both edges.

NOTE. When using a recalled data file, the Data Pattern fields are updated to indicate the state of the
settings when the data was acquired.

Selecting the signal conditioning
Wavelength, Filter, Bandwidth
Use this control to select what type of filtering, if any, you want performed on the selected channel. The
available filters depend on the capabilities of the module.

If the Filter is set to None, you can use the Bandwidth box to select the bandwidth of the channel. The
available bandwidth selections depend on the capabilities of the module. Refer to the documentation for
the module about its filter or bandwidth settings.

80SJNB Printable Application Help

35

Operating basics

Selecting the signal conditioning

The list of hardware filters are specific to the selected module as data source. A comprehensive list of the
hardware filters, the standards they support, and the data rates, are listed in the DSA8300 Programmer
Manual. The manual specifies the token names that are used by the programmatic interface to select a
particular filter.
The range and resolution of scale values for a selected channel is dependent on multiple factors: module
type, probe type if attached, and an external attenuation factor. Use the DSA8300 programmatic interface
commands when an external attenuation factor is required. See the DSA8300 product documentation
for details.

Scope Noise

Scope Noise is a relevant parameter for the TDECQ measurement. For optical modules, enter scope
noise in μW. For electrical modules, enter scope noise in μV. The default setting is dependent on the
acquisition module.
TDECQ measurements require you to specify the amount of scope noise contributed to the signal, DUT,
noise. Channel noise depends on type of the module and Signal Conditioning configuration: Wavelength,
Filter, Bandwidth.
Default noise values are loaded based on the selected module and its configuration.
You can measure and enter the scope noise manually, or use the Scope Noise Characterization utility,
installed on the instrument, to measure the scope noise. Access to the utility is from the DSA8300
Applications pull down menu.
The utility creates a scope noise file that can be imported by the 80SJNB application. Open the application,
select all modules of interest and launch the Measure process. The results are stored in a file called
ScopeNoiseDB.ini located at C:\Users\Public\Tektronix\TekApplications.
When Scope Noise Import is selected, 80SJNB imports the scope noise measured for the user specified
Signal Conditioning configuration.

BWE

BWE (Bandwidth Enhancement) is a process of creating and applying a digital filter with the following
goals:
NOTE. Bandwidth Enhancement is currently for use with optical modules: 80C17, 80C18, 80C20, and
80C21.

36

80SJNB Printable Application Help

Operating basics

Selecting the signal conditioning

Improve the module reference receiver filters to more closely match an ideal response, specified by
Standards as 4th order Bessel-Thomson (BT).
Enable non-standard receiver rates or bandwidths.
Increase or decrease the bandwidth of the optical channel.
Specifically, for the 80C17 and 80C18 optical modules, BWE provides a bandwidth boost. For the
80C20 and 80C21 optical modules, BWE shapes the transfer function to approach as much as possible
to 4th order BT response.
The BWE filters are created from the S-parameters of the module.
Each module configuration, (wavelength, filter, and bandwidth) has an equivalent s1p S-parameter file.
Based on the Signal Conditioning configuration selected, the appropriate file needs to be selected when the
BWE filter is created.
The S-parameters are available (on a USB flash drive) for the following modules.
80C17 and 80C18: S-parameters available as an option at the time of purchase.
80C20 and 80C21: S-parameters provided at the time of purchase.
Press the Configure Filter button to either load an existing filter or create a new filter.

80SJNB Printable Application Help

37

Operating basics

Selecting the signal conditioning

Load From File. Load From File allows you to apply a previously created filter. Use the Browse button to
navigate to the saved filter file.
Create Filter. Create Filter allows you to create a new filter based on the parameters you set.
Enter a filter name in the dialog screen.
Set the Data Rate of the signal.
Navigate to an S-parameter file that matches the optical module’s attributes.
Set the Target Bandwidth to the 3 dB bandwidth for the Bessel-Thompson filter. The default is 0.5 of
the Baud rate of the signal.
Set the Bandwidth Limit that specifies the roll-off frequency of the BWE filter. The default is 0.9 of
the Baud rate of the signal.
You have the option to save the created filter (Save Filter) for use at a later time or to apply it during
the next acquisition (Apply).
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NOTE. When saving the acquired data (using File > Save Data), the data patterns are saved without the
bandwidth enhancement but the bandwidth enhancement parameters are saved in the context. When
the saved data is recalled, the bandwidth enhancement is reapplied. The Filter must be inserted in the
Signal Path to apply the BWE.

Selecting the pattern clock
The Pattern Sync built-in capability provides user pattern synchronous triggers. The feature, enabled by
the Advanced Trigger Option (ADVTRIG), is driven by the Pattern Clock.
The available Pattern Clock sources depend on the instrument configuration. The default selection is
Clock/Prescale Input, and this selection is available for all configurations. Connect the clock source to
the CLOCK INPUT/PRESCALE TRIGGER front-panel connector.
When the oscilloscope is equipped with one or more clock recovery capable modules, the CR units are
also available as sources for the Pattern Clock.
Each native clock recovery source appears on the Pattern Clock source list twice to allow for two different
configurations:
Selecting Cx Clock Recovery sets the instrument to pick up the recovered clock from the back
of the module using and internal signal path.
Selecting Cx CR to Clock/Prescale Input sets the instrument clock recovery signal source to the
CLOCK INPUT/PRESCALE TRIGGER connector on the front panel. Connect the output of the clock
recovery module to the front panel CLOCK INPUT/PRESCALE TRIGGER input.
Depending on the data rate, choosing one configuration over the other could result in different intrinsic
jitter performance. See Selecting Clock Recovery (see page 33). In general, if there is SSC then a
particular cabling setup is necessary; only external Clock Recovery (such as with a Tektronix CR286A)
can be used. If the Tektronix 82A04/82A04B Phase Reference module is used in the absence of SSC,
the 82A04/82A04B setup determines the jitter performance. The intrinsic jitter of the pattern trigger
circuit becomes invisible.

When the clock source is a dedicated Clock Recovery Unit, like the Tektronix CR125A, CR175A,
or CR286A, the instruments are controlled by a USB-link to the oscilloscope. The syntax of the
programmatic interface is specified in the DSA8300 Programmer Manual. The header of the commands
are TRIGger:CLCRec:CRC.
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Selecting the source
The application takes measurements on waveforms specified as sources (also called signal sources). The
source can be a channel (CH1 through CH8) or a defined math waveform. You can use any defined math
waveform, whether it is defined in the 80SJNB configuration as a differential setup or in the TekScope
application.
Specify whether the source waveform is NRZ or PAM4.
NOTE. Selecting PAM4 disables SSC.
If your signal source uses Spread Spectrum Clocking (SSC), select the SSC check box so that the
application can make accurate measurements that account for clock rate modulation

NOTE. If a saved data file is recalled, the signal source selection remains unchanged but all result
panels will indicate the recalled data file as the source. The “SSC is present” field is updated to match
the setting from the recalled data file.

See also:
About Spread Spectrum Clocking (SSC) (see page 41)
Clicking the Diff button displays the dialog box to create a differential Math waveform by defining a
positive and negative waveform source (the negative waveform source is subtracted from the positive
waveform source). This generates a single mathematical waveform that the 80SJNB application can use
as the waveform measurement source.
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About spread spectrum clocking (SSC)
Spread Spectrum Clocking (SSC) is the technique of modulating the clock frequency to minimize EMI
effects. SSC affects the analysis process and the results of jitter, noise and BER measurements. If SSC
is not corrected for its effects, the results show as a large amount of periodic jitter components that are
reflected in the total jitter and noise, and ultimately in the BER estimates.
When SSC is present, 80SJNB measures the attributes of SSC and corrects the results.

SSC configuration requirements
NOTE. SSC is available only for NRZ coding measurements.
If using clock recovery, the clock recovery unit must be able to handle SSC. Use one of the Tektronix
BERTScope clock recovery instruments if SSC is present in the signal.
The TekScope must have an 82A04 or 82A04B Phase Reference Module installed. The module minimizes
the effect of the SSC on the data by sampling synchronously the data and clock. Also, by acquiring
the clock in the 82A04/4B module, 80SJNB characterizes the SSC present in the clock and uses that
information to correct the jitter, noise, and BER measurements performed on the data.
TIP. The “SSC is present” check box is disabled if the Phase Reference module is not installed in the
instrument.
Use the following settings to optimize the SSC phase correction for the signal you are measuring:
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Data rate range

Clock recovery
frequency 2

Clock recovery
output rate 1, 2

Data:Clock ratio
(JNB)

Phase reference
frequency (JNB)

500 Mbps – 1 Gbps

Data Rate * 4

Standard

1:4

Data Rate * 4

1 Gbps – 2 Gbps

Data Rate * 2

Standard

1:2

Data Rate * 2

2 Gbps – 4 Gbps

Data Rate

Standard

1:1

Data Rate

4 Gbps – 8 Gbps

Data Rate

Subrate (1/2)

2:1

Data Rate/2

8 Gbps – 12.5 Gbps

Data Rate

Subrate (1/4)

4:1

Data Rate/4

xxx

1
2

The Clock Recovery unit clock output is either Standard or Subrate Clock.
Clock recovery is typically provided from a CR125A, CR175A, or CR286A BERTScope Clock Recovery Instrument.

When you instruct 80SJNB that the data has SSC (by checking the “SSC is present” check box), the
following constraints are enforced based on the current Data Rate:
Phase Reference source is selected.
Phase Reference frequency is set to the recommended value in the table Configuration Settings for SSC.
A recommended Data:Clock Ratio is displayed to suggest the recommended subrate clock.
NOTE. Changes to the Data Rate are reflected in the Phase Reference Frequency and Data:Clock Ratio.
You must make the appropriate changes to the Clock Recovery unit parameters.
The Full Numeric Results page shows the status (on or off) of the SSC setting. The results of the SSC
analysis are presented in two forms, numeric results and a plot. When viewing the full numeric results
table, the SSC Modulation section has two fields: Magnitude and Frequency. Magnitude represents the
depth of the SSC clock modulation in parts-per-million (ppm) and Frequency reflects the SSC modulation
frequency.
To view the plot of the SSC modulation profile, select the Plot>SSC>SSC Profile.

TIP. The configuration settings are also available through the GPIB programming interface of the
oscilloscope. Refer to the information provided with the oscilloscope.
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About Serial Data Link Analysis (SDLA) Signal Path Settings
The Signal Path Settings are available for use with the 80SJNB Advanced and PAM4 versions. If you
are using the 80SJNB Essentials version, you're allowed to use the dialog boxes but are not allowed
to place any of the functions into the signal path.
The Signal Path settings allow you to emulate the environment your signal encounters, all the way from
the transmitter to the receiver. With the Signal Path dialog box, your signal path is represented by a line
from the transmitter (Tx) to the Receiver (Rx). Along this line, you have the ability to emulate an arbitrary
filter and/or a channel. You can then define an equalizer to compensate for the effects the filter and channel
introduce. Also, fixture de-embed is supported.

Selecting a signal path arrow (Filter, Channel, or Equalizer) inserts or removes the function from the signal
path. When inserting a function into the signal path, its dialog box automatically displays.
Selecting a signal path button (Filter, Channel, or Equalizer) displays the dialog box for that function
without inserting or removing the function from the signal path.

By simulating the signal environment, you can effectively emulate probing the signal at the receiver rather
than the output of the transmitter. With the use of the Equalizer, you can then design compensations to
improve the signal quality at the receiver.
Full signal path functionality supports PAM4 signals.
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TIP. You can move a function in and out of the signal path without affecting any settings.
To learn more about each of the signal path settings, select the following:
Filter (see page 44)
Channel (see page 45)
Equalizer (see page 48)

Setting Filter Conditions
The Signal Path Filter allows you to specify an arbitrary linear FIR filter to be applied to the acquired data
pattern. For instance, the transmitter may artificially enhance the signal at certain frequencies to overcome
known problems in the channel. You can use a filter to emulate this action or compensate for transmitter
signal pre-emphasis. Use the filter to insert a continuous-time linear equalizer (CTLE) in the signal path,
which standards typically specify for PAM4 signaling.
You can define or load a CTLE from the Equalizer. Inserting a de-embed filter is the most common
use of the Filter. Use the SDLA (Serial Data Link Analysis) tool to generate the de-embed filters. See
details below.
To use the filter, move the Filter function into the signal path and use the Filter file box or browse button to
specify the filter file. The default location for the filter files is in the Windows/Documents folder. A few
filter files are provided as examples, but you are responsible for providing the filter files.
To use the Filter block for de-embedding, you will need an additional software tool to create a
de-embedding filter from the S-parameters of the fixture. Please visit the www.tektronix.com/sdla Web
site, or contact Tektronix Support for details.
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See Uncorrelated Scaling (see page 54) for information about this setting.
The following is an example of the filter file format:
@ 5.7e-005, 2.4e-005, 5.4e-005, 2.1e-005, 5.1e-005

The '@' means that it is valid for all frequencies.
Up to 20,000 coefficients may be specified.

Setting Channel Conditions
The Signal Path Channel allows you to emulate the channel (interconnect or lane) carrying the signal.
There are two ways to define the channel, with Time Domain (see page 47) waveforms and Frequency
Domain (see page 45) S-parameters.
See Uncorrelated Scaling (see page 54) for information about this setting.

Frequency Domain
With Frequency Domain selected, the channel is defined with an S-parameters file. Use the file selection
box or Browse button to select the file. The default location for the files are in the Windows/Documents
folder. You are responsible for providing the S-parameters file.

The S-parameters file can contain data for 1-port, 2-port, or 4-port devices. Once a file is selected,
the application reads its contents and generates the appropriate dialog for you to select the particular
S-parameter in the file to use.
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1-Port. Files with 1 port of data contain only 1 S-parameter so they do not require any further input. These
files may be IConnect 1-port files or Touchstone 1-port files.
2-Port. Files with data for 2 ports contain 4 S-parameters as a 2x2 matrix. These are Touchstone 2-port
files. When the application recognizes such an S-parameter file, a dialog is created for you to select the
S-parameter representing channel transmission. The typical selection is S21, and is the default selection,
but this may need to be changed if the file contains a 2x2 subset of the 4x4 matrix of S parameters defining
a 4-port system.

4-Port. Files with data for 4 ports may contain single-ended or mixed-mode data. These are Touchstone
4-port files.
If the data is single ended, you must map the port numbers as used in the file to physical locations in your
link. A default mapping is assumed. The application will use this mapping to compute the Sdd21 parameter
(for transmission of a differential signal) from the appropriate four S-parameters measured using single
ended data.

If the data is mixed mode, you must select the data layout in the file. The most common layout is DC12
and is the default selection. The application always uses the Sdd21 parameter for computing the transmitted
waveform no matter which mapping is selected.
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NOTE. 80SJNB Advanced uses the 'insertion loss' information only.

Time Domain
With Time Domain selected, the Reference waveform and Transmitted waveform generate the channel
behavior. Use the file boxes or browse buttons to select the files you want to use. The default location
for the files is in the Windows/Documents folder. You are responsible for providing the time domain
waveform files.
NOTE. We recommend that the waveform file be a measurement of the channel from a Tektronix TDR/TDT
system. Required raw oscilloscope waveforms are:
a. A reference throughput (no DUT is inserted, just a throughput connection between the TDR step
source and the acquisition channel on the TDT end).
b. A DUT throughput measurement (the TDR step source and the TDT acquisition channel are connected
through the DUT).
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About the Equalizer
The equalizer compensates for transmission channel impairments in the form of frequency-dependent
amplitude and phase distortions resulting in intersymbol interference (ISI) in the communication data
stream.
80SJNB provides tools to support three types of equalizers: CTLE (Continuous Time Linear Equalizer),
FFE (Feed Forward Equalizer), and DFE (Decision Feedback Equalizer). The linear feed-forward
equalizer (FFE) is defined by a user specified number of taps, taps per symbol (or unit interval), and the
weight of each tap. The equalizer becomes a decision-feedback equalizer (DFE) when the number of DFE
taps is set to a number larger than 0.
NOTE. Tap values and weights are used interchangeably.

To learn about setting up the Equalizer, see:
Continuous Time Linear Equalizer CTLE (see page 49)
Equalizer Taps (see page 50)
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Uncorrelated Scaling (see page 54)

Continuous Time Linear Equalizer (CTLE)
The equalizer includes an optional filter that is intended to be a Continuous Time Linear Equalizer.
However, when loading the equalizer from a filter file (extension .flt) any filter may be used. If the radio
button Define CTLE is selected the user can define a 1- or 2-stage CTLE.

The schematic in the CTLE Definition dialog portrays each stage (assuming 2 poles per stage) of the CTLE
filter. The plotted function schematically shows the frequency response of the filter.
You can select a standard with a specified peaking in dB, which automatically fills in the remaining
parameters of the dialog, or manually define the remaining parameters of the dialog.
ADC is the gain at DC.
fZ is the frequency of the zero of the filter.
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fP1 is the frequency of the first pole.
For a 2-pole stage, fP2 is the frequency of the second pole. For a 1-pole stage, fP2 is not defined.
When 2 stages are defined, the filters defined by the separate stages are convolved to produce the filter.
NOTE. Clicking Apply or OK causes the filter to be included in the updated definition of the Equalizer, but
when you exit this dialog and return to the Signal Path – Equalizer dialog, you must click Apply or OK
there, too, in order for the updated definition to now define the Equalizer. In addition, the Equalizer must
be made active for its definition to be used at all.

Equalizer Taps
The behavior of the equalizer is controlled by the number of taps and the tap values. Using the equalizer
requires that you specify the number of FFE and DFE taps, and the FFE spacing of the taps. You can also
incorporate an equalizer filter delay by specifying a reference tap to compensate for precursor channel
effects.
You can manually set the FFE and DFE tap values, or you can use the Autoset Taps button to let the
application calculate the tap values.

Go to FFE Taps description (see page 50)
Go to DFE Taps description (see page 51)

FFE Taps
The FFE Taps are weights applied to a set of samples taken from the data stream to compensate for
channel impairments manifested in the form of ISI. The number of FFE Taps represent the length of
history in data samples that contribute to the computation of a current bit. Data stream samples could
be distanced at unit intervals, in which case the number of FFE taps represents the number of preceding
bits that contribute to the correction of the current bit. Alternatively, the data stream could be sampled
at a higher rate per bit, yielding a fractionally-spaced FFE tap set.

50

80SJNB Printable Application Help

Operating basics

Equalizer Taps

The number of FFE taps defaults to 1, with the capability to specify up to 100 taps. The default FFE tap
spacing is at unit intervals. You can configure up to 10 taps per symbol.
The FFE Tap values could be specified by you using the FFE Taps dialog, or computed by the application
with the Autoset Taps button.
Go to Autoset Taps description (see page 53)
Go to Saving and Loading Taps (see page 53)

Pressing the FFE Taps button displays a dialog showing the current FFE tap values. You can specify each
FFE tap coefficient individually. Pressing the Defaults button sets the first FFE tap to 1 and the rest to 0.

You can use the Save Taps button to save a set of coefficients to a file. Use the Load Taps button to load
saved Tap files.

DFE Taps
DFE taps are weights applied to the previous digital decisions made by the slicer (comparator + latch). The
number of DFE Taps specifies the number of bits contributing to the current input to the slicer. The default
number of DFE Taps is 0, in which case the equalizer is a linear FFE one. The maximum number of DFE
Taps is 40. Weights are scalars specified by you or computed by the Autoset Taps function.
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See Autoset Taps (see page 53) for a description about using the autoset taps function.
Pressing the DFE Taps button displays a dialog showing the current DFE tap values. You can specify each
DFE tap coefficient individually. Pressing the Defaults button sets all DFE tap values to 0.

You can use the Save Taps button to save a set of coefficients to a file. Use the Load Taps button to
recall saved Tap files.
TIP. When using the Equalizer, you are required to always have at least 1 FFE tap. DFE taps are optional.

Filter Settings
FFE Reference Tap. The FFE Reference Tap is a filter delay in unit intervals that should be set to
compensate for the delay between the transmitter output and the equalizer input. The value of the
Reference Tap is constrained by the number of FFE Taps and the number of taps per symbol.
DFE Rise Time Selector. The Rise Time Selector specifies the Gaussian filter used to emulate the DFE
feedback path band-limited behavior. The rise time defaults to Track Data Rate, in which the configuration
is set to 1/5 of the unit interval equivalent with the data rate. Track tap interval designs a Gaussian filter
with a rise equal to 1/5 of the spacing between taps. Selecting User allows you to specify the rise time
from 1 ps to 4 ns.
Uncorrelated Scaling. See Uncorrelated Scaling (see page 54) for a description.
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Autoset Taps
The tap autoset function computes a set of tap values that optimize the eye opening for the data pattern
applied to the input of the equalizer. If the DFE tap number is 0, the algorithm yields an optimal set of FFE
taps, while if the equalizer is specified as a DFE by a positive DFE tap number, the Autoset Taps algorithm
jointly optimizes the forward and feedback loop tap coefficients. The optimization algorithm is the
least-mean-square error (LMS) and the optimization targets the signal to noise ratio at the sampling phase.
The Autoset Taps will account for the FFE Taps/Symbol and Reference Tap specifications.
The tap autoset algorithms computes a set of FFE and DFE taps using a least-mean-square optimization
algorithm. The optimization algorithm is the least-mean-square error (LMS) and the optimization targets
the signal to noise ratio at the sampling phase. If TDECQ computation is enabled, the Autoset Taps
performs an MMSE (minimum mean square error) optimization according to the IEEE standard.
NOTE. You can autoset tap values even if the Equalizer is not inserted in the signal path.

Saving and loading taps
Use these controls to save or load a set of taps from a file. The browse directory defaults to Windows/My
Documents and the file extension is .tap.
The file format is the following:
<Tektronix>
<TapFile>
<FFE>
<TapsPerSymbol>value<\TapsPerSymbol>
<ReferenceTap>value<\ReferenceTap>
<Tap1>value<\Tap1>
<Tap2>value<\Tap2>
...
<Tapn>value<\Tapn>
</FFE>
<DFE>
<Tap1>value<\Tap1>
<Tap2>value<\Tap2>
...
<Tapn>value<\Tapn>
</DFE>
</TapFile>
</Tektronix>
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Uncorrelated scaling
The signal path settings (Filter, Channel, Equalizer) each have an uncorrelated scaling setting. The
Uncorrelated Scaling value multiplies the uncorrelated random noise RMS and uncorrelated periodic noise
values. Uncorrelated noise scaling affects the uncorrelated jitter as projected through the average slew rate.
The 80SJNB Signal Path does not process uncorrelated noise in any other way.
If you insert a default equalizer (an FFE Tap 1 value equal to 1, and zero DFE taps) in the Signal Path
and set the Uncorrelated Scaling factor to its minimal value (0.01), the configuration will isolate the
effects of noise on jitter measurements. This configuration produces results that correlate with “jitter
only” type analysis tools.
NOTE. The overall Signal Path uncorrelated scaling factor is the product of all signal path uncorrelated
scalar values of the active functions.

About analysis settings
The Analysis settings affect how measurements are made and displayed. The settings are saved with the
80SJNB application whenever it is closed so that restarting the application results in using the same
settings.

NRZ Analysis dialog box
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PAM4 Analysis dialog box

TIP. Changes to Analysis settings are reflected in the current plots and results.

Setting the analysis method
The Method selection sets which analysis methodology to use for the Jitter and Noise breakdown:
The Spectral + BUJ (Bounded Uncorrelated Jitter) is using a combination of spectral isolation of
the periodic components and the analysis of the cumulative distribution function (CDF) of the
uncorrelated jitter and noise data, before and after spectral separation. The presence of crosstalk
dictates the selection of this method.
The Spectral (Legacy) mode relies on spectral separation of the periodic and random components.
The default setting is Spectral + BUJ. When switching the analysis method between the two options, the
acquisition data is preserved, and new results are recomputed, displayed, and plots made available. When
the selected coding scheme is PAM4, the Spectral+BUJ is the only analysis method available.

Setting the Rx optimizer
You can define the receiver slicers of the eye(s) or have the slicers determined automatically by the Rx
Optimizer.
The Rx optimizer is a set of eye analysis algorithms that select the optimum point within each eye
(both threshold and phase) for placing the receiver slicer. Values entered in the text boxes for decision
thresholds and sampling phases are ignored save in extreme cases that the optimizer cannot analyze,
e.g., a completely closed eye.
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For NRZ the user selects one of the two radio buttons “User Specified” and “Optimize Receiver.”
For PAM4 the “User Specified” control is still present but now there are three radio buttons for the
optimizer, one for each of the optimizer’s two modes. In the first mode, labeled Optimize to Center Eye
OIF (Common Phase), the receiver slicers of the three eyes are constrained to have the same sampling
phase. The algorithm JNB uses in this mode is defined by the standards OIF CIE 2014.230 and IEEE
802.3bj. The second Common Phase option for optimized receiver is according to the IEEE specification.
The third option has the three receiver slicers that are separately optimized for each eye. This algorithm
decides the relative importance of horizontal and vertical spacing around the receiver slicer. In cases where
one is substantially more important than the other the optimum receiver slicer may be placed closer to
an edge of an eye than might be expected. This is correct behavior.
The IEEE standard for optical receivers sets the reference decision threshold to the average optical power,
and adds and subtracts 1/3 of the optical modulation amplitude. The sampling phase is common for all
three eyes, and it is the middle of the unit interval.
The receiver slicers are denoted by white crosses in the SP Receiver PDF Eye figure (Matlab version
of the figure only). The following figure shows receiver slicers with independent phases computed by
the Rx Optimizer.

Setting the decision thresholds
The Decision Thresholds, one per eye (one for NRZ and three for PAM4), specify the boundary between
two adjacent signal levels.
When Optimize Receiver is selected, the decision threshold text boxes are disabled and the Rx Optimizer
computes the optimum decision points (both decision thresholds and sampling phases).
When Optimize Receiver is not selected, the decision threshold text boxes are enabled.
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When Optimize Receiver is not selected and Absolute is selected, the decision thresholds use the absolute
value provided in volts (electrical) or watts (optical).
When Optimize Receiver is not selected and Normalized is selected, the decision thresholds are calculated
based on waveform data according to the percent value of the signal amplitude.

Setting the time unit
The Time Unit sets the units (Seconds or Unit Intervals) used when displaying the measurement results.

Setting the sampling phases
The Sampling Phases determine the times of the sampling points and of all noise and vertical eye opening
measurements within the unit interval.
When a PAM4 signal is analyzed, either each eye can have its own Sampling Phase or all three phases
can be set to the same time.
When Optimize Receiver is selected, the sampling phase text boxes are disabled and the Rx Optimizer
calculates the optimum decision points (both decision thresholds and sampling phases).
For PAM4 there are two options to optimize using a common phase:
If not selected, the optimization is unconstrained and the software calculates the optimum sampling
point for each eye independently of the other eyes.
If selected the optimization is constrained so that all sampling points are the same. When Optimize
Receiver is not selected the sampling phase text boxes are enabled according to OIF and IEEE
standards.
When Optimize Receiver is not selected, and Seconds is selected, the sampling points use the absolute
value entered. Zero seconds is the center of the unit interval.
When Optimize Receiver is not selected, and Unit Intervals is selected, the sampling point is calculated
based on the fraction of a unit interval. Zero UI is the center of the unit interval.

Setting the measurement bit error rates (BER)
There are three BER values to set: Global, JxBER and JyBER. The Global BER is used for all
measurements qualified by a BER value. Total jitter is also calculated for JxBER and JyBER.
All three total jitter values are displayed on the eye tabs. The JxBER and JyBER total jitter values are
labeled Jx and Jy unless the specified BER has the values 2.5e-3 or 2.5e-10, in which case they are labeled
J2 or J9, respectively.

ER Correction Factor
Extinction Ratio Correction Factor is a compensation for offsets and drifts in photodiodes, which can
generate nonzero voltage when no light is present at the input. This can occur due to lack of dark level
compensation, photodiode dark currents, or can be generated by electrical amplifiers following the diode.
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The Correction Factor values run from -99% to 100% of signal amplitude. Default is 0%.

TDECQ Measurement
The computation of the TDECQ (Transmitter and Dispersion Eye Closure Quaternary for PAM4) needs to
be enabled by the user.
The histogram width on which the TDECQ computation is enabled is specified in % of UI. The default is
4%, and the range is 0% – 10%.
TDECQ Extended Analysis selection instructs the algorithm to perform an iterative process to optimize
the TDECQ value for the left or right histograms.
The Adaptive Threshold Adjustment, when checked, locates the optimal position for minimum TDECQ
measurement.

Computing rise/fall times
The transition times between signal levels are optionally computed by selecting the check box labeled
Compute Rise/Fall Times. The definition of the reference levels can be set in percent using the Low and
High text boxes.
For NRZ the rise/fall times are displayed on the Global tab. For PAM4 they are displayed on the Rise/Fall
tab.

About mask test settings
The Mask Test setup dialog defines the target and parameters of mask testing.
There are two 80SJNB statistical analysis products on which mask testing can be performed, the SP
Receiver PDF Eye and the BER Contours. Both of these are defined at the receiver side of the Signal
Path emulator.
The mask definitions are loaded from Tektronix standard format mask files. These files include parameters
that define the signal, the mask polygons, and the mask testing qualifiers.
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NOTE. Changes to mask test settings are reflected in the current plots and results.

Selecting the mask test
Click the Load button and browse to select a mask file, which has the extension .msk. Parsing the file
fills in the Mask Test Definition fields of the setup dialog. These values can be edited and, by using the
Save button, saved in another mask file.
A mask file contains the following information:
The name of the standard for which the mask was defined
Signal type is limited to NRZ
Standard data rate. This rate can be edited, and if the acquired signal rate and mask file data rate do
not match, a message “Mask is scaled to signal rate” is displayed
The polygons that define the mask testing area, which are visible on the target plots
Target Hit Ratio, defined as the sum of probabilities that the modeled signal is within the mask
Target Mask Margin, defined as a positive or negative percentage of the specified mask size
Target BER value that defines the curve of constant BER that will be used for the BER Contour
mask testing
Checking Horizontal Autofit causes the mask test to be evaluated at all horizontal positions to obtain the
best test result in terms of maximum mask margins or minimum hit ratios.
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Selecting the runtime options
Check Enable Mask Testing button to perform mask testing.
The Test Target pull down list specifies the JNB analysis products to which the mask can be applied: SP
Receiver PDF Eye or the BER Contour.
When changing the Mask Test Target the relevant plot with the Mask will be displayed. If the target plot
is displayed already, the mask will be added to the plot. If the plot is not displayed, the test target plot
will replace the upper left corner plot.
Consider the use cases for mask testing on the PDF Eye:
Given a target Hit Ratio, find the largest mask margin that does not exceed that hit ratio.
Given a target Mask Margin, find the actual hit ratio.
Given a Target Hit Ratio and Mask Margin, determine the Pass or Fail status.
The use cases for mask testing on BER Contours are:
Given a target BER, find the largest mask margin that does not exceed that BER.
Given a target Mask Margin, find the BER Limit, which is the lowest BER contour that contains
the mask.
Given a target BER and Mask Margin, determine the Pass or Fail status.
For PDF Eye mask testing, there are three polygon areas to consider: overshoot, center and undershoot.
You can choose to test against all regions or only the center polygon.
The settings are saved with the 80SJNB application whenever it is closed so that restarting the application
results in using the same settings. Using the File > SaveSettings control saves the settings for later use.
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About PAM4 signal analysis
The 80SJNB PAM4 option performs the full jitter, noise and BER analysis on the PAM4 modulated
signals, to support measurement and analysis of 100-400 Gbps electrical and optical communication links.
Signal impairment sources for PAM4 are categorized in similar ways as for NRZ systems: uncorrelated
jitter and noise sources, crosstalk, bounded and unbounded types. JNB will perform the full analysis on
each PAM4 eye, and also performs a set of global PAM4 specific measurements.
The PAM4 signal analysis process is as follows:
1. The signal Coding is selected from the Analysis panel. Default is NRZ, and the user has the option
to select PAM4.
2. If PAM4 is selected, the JNB Results tab changes to a set of 3 Results tabs (Eye0 lowest eye, Eye1
middle eye, and Eye2 upper eye). The content of each result tab is the same as for NRZ, and includes a
comprehensive jitter and noise analysis with the BER estimations of total jitter and noise.
3. An additional Global tab specific to PAM4 displays a result panel containing a set of transmitter side
and receiver side PAM4 specific measurements.
4. Each Plot will reflect the signal and processing characteristics of a PAM4 signal. Eye plots contain
all three stacked eyes for PAM4. Horizontal and vertical Bathtub curves are composite plots of each
individual eye.

About TDECQ measurements
TDECQ is a measure of an optical transmitter’s vertical eye closure when transmitted through a worst
case optical channel, as measured with a bandwidth equivalent to a reference receiver. The signal path
includes an equalizer, as specified by IEEE standards. The reference receiver and the equalizer are
implemented in the 80SJNB software.
The acquired waveform is processed to find the largest noise that could be convolved with the signal by an
ideal reference receiver when optimally equalized by a reference equalizer. The optimization is an iterative
process until a target SER is met. The attributes and targets of optimization are defined by Standards.
Low TDECQ values are qualifiers of high quality optical links. The threshold of pass/fail for TDECQ
measurements are specified by Standards.
There are two major operation modes for TDECQ, one for optimal throughput (Fast TDECQ enabled)
and one for a comprehensive jitter, noise and BER analysis, which includes the TDECQ measurement
(Fast TDECQ disabled).
The Fast TDECQ Acquisition Mode (see Acquisition dialog) will acquire the full pattern, typically an
SSPRQ one as required by IEEE Standard. Focus is on maximum acquisition and processing speed.
This mode yields the fastest response for TDECQ measurement, along with OMA Outer (Optical
Modulation Amplitude), ER (Extinction Ratio), and AOP (Average Optical Power). Additional controls
in the Analysis panel allows for an extensive optimization cycle (Extended Analysis) and the vertical
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optimization of the position of TDECQ measurement (Adaptive Threshold Adjustment). Enabling these
require extra processing time.
If the Fast TDECQ Acquisition Mode is unchecked, the full acquisition and analysis cycle is performed.
This mode of operation analyzes all three PAM4 eyes and performs global measurements that include
TDECQ. You have a choice to add the computation of TDECQ to this cycle by checking the Compute
TDECQ button available in the Analysis panel. The TDECQ Extended Analysis is available for this
acquisition mode as well.
Signal conditioning with BWE (Bandwidth Enhancement) in the Acquisition panel allows you to create
and apply a digital filter based on the S-parameters of the acquisition module.
Scope noise is a key parameter for the TDECQ measurement. It has to be removed from the measured
signal noise to allow the optical link to account only for the added noise measurement. Default values
are entered based on the selected module and its configuration. Use the DSA8300 measurement system
to measure the scope noise for the particular module configuration and then import the value. The
Acquisition control panel requires a scope noise value.
The equalizer FFE taps values are displayed in the TDECQ Eye plot. Double-click on the plot, and the
image is opened in Matlab with additional details, such as the tap values and the scope noise that was used
for the TDECQ measurement.

You can modify the FFE tap values for correlation studies. Access the tap values is from the Signal Path
Equalizer (see page 48) dialog screen. Enter the new FFT Taps values and click on Apply.
If Compute TDECQ is active, clicking on Autoset Taps in the Equalizer dialog uploads the TDECQ
tap values.
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See Selecting the Signal Conditioning (see page 35) for more information about BWE, Scope noise, and
the DSA8300 application that automatically measures scope noise.

Taking measurements
The most relevant oscilloscope measurement settings are accessible using the Analysis dialog box of
the 80SJNB application.

Displaying measurements
You can use the tool bar to select how the results are displayed: numeric results, plots (up to four), or a
combination.
What do you want to do?
Display the definitions of Jitter measurements (see page 64)
Display the definitions of Noise measurements (see page 65)
Measurement Algorithms (see page 133)
Go to Working with Numeric Results (see page 83)
Go to Working with Plots (see page 72)
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Jitter measurement definitions
Jitter measurements

Description

Random Jitter
RJ (RMS)

Measured Random Jitter

RJ(h) (RMS)

Horizontal component of random jitter

RJ(v) (RMS)

Vertical component of random jitter induced by noise converted to jitter through an
average slew rate

Deterministic Jitter
DJ

Measured Deterministic Jitter

DDJ

Data Dependent Jitter

DCD

Duty Cycle Distortion

DDPWS

Data Dependent Pulse Width Shrinkage

BUJ(d-d)

Measured Bounded Uncorrelated Jitter, Dual Dirac model

PJ

Measured Periodic Jitter (peak-to-peak)

PJ(h)

Horizontal component of periodic jitter (peak-to-peak)

PJ(v)

Vertical component of periodic jitter (peak-to-peak) induced by noise converted to jitter
through an average slew rate

NPJ(d-d)

Measured NonPeriodic Jitter, Dual Dirac model

Total Jitter @ BER
TJ (1E-12)

Total Jitter at user-specified BER

Eye Opening (1E-12)

Horizontal Eye Opening at user specified BER

Other Jitter measurements
Jx (JxBER)

Total Jitter at second user-specified BER

Jy (JyBER)

Total Jitter at third user-specified BER

Rj(d-d)

Random jitter based on the dual Dirac model

Dj(d-d)

Deterministic jitter based on the dual Dirac model

xxx

NOTE. J2 Jitter: For a BER specified as 2.5E-3, the Total Jitter becomes J2 Jitter. J2 Jitter measures all
but 1% of the statistical total jitter distribution.
J9 Jitter: For a BER specified as 2.5E-10, the Total Jitter becomes J9 Jitter. J9 Jitter represents an
estimation of all but 10E-9 of the statistical total jitter distribution.
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Noise measurement definitions
Noise measurements

Description

Random Noise
RN (RMS) 1

Measured Random Noise

RN(v) (RMS)

Vertical component of random noise

RN(h) (RMS)

Horizontal component of random noise induced by jitter converted to noise through an
average slew rate

Deterministic Noise
DN

Measured Deterministic Noise

DDN

Data Dependent Noise

DDN(level 1)

Data Dependent Noise on logical level 1

DDN(level 0)

Data Dependent Noise on logical level 0

BUN(d-d)

Measured Bounded Uncorrelated Noise, Dual Dirac model

PN 1

Measured Periodic Noise

PN(v)

Vertical component of periodic noise (peak-to-peak)

PN(h)

Horizontal component of periodic noise (peak-to-peak) induced by jitter converted to
noise through an average slew rate

NPN(d-d)

Measured NonPeriodic Noise, Dual Dirac model

Total Noise @ BER
TN (1E-12)

Total Noise at user-specified BER

Eye Opening (1E-12)

Eye Opening at user-specified BER

Eye Amplitude

The amplitude of the eye computed as the mean-to-mean of logical 1 and logical 0 bit
levels sampled at the user defined Sampling Phase.

xxx

1

Uncorrelated random noise (RN) and periodic noise (PN) measurements are performed on both logical levels 1 and 0 to account for significant
differences, which may be the case when the measurements are performed on optical signals.

SSC Modulation Measurement Definitions
SSC modulation
measurements

Description

Magnitude

Spread spectrum clock modulation magnitude of the clock in parts-per-million (ppm) units.

Frequency

Spread spectrum clock modulation frequency.

xxx
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80SJNB PAM4 measurements
Eye and Level measurements for PAM4 and NRZ
Measurement

Description

Eye measurements
RJ RMS

Standard deviation of the random (Gaussian) jitter

TJ

Total jitter at target BER

Width

Eye width at target BER

Decision Threshold

Decision thresholds for horizontal analysis

RN RMS

Standard deviation of the random (Gaussian) noise

TN

Total noise at target BER

Height

Eye height at target BER

Sampling Phase

Phase of the sampling point

Center Deviation

Sampling phase skew relative to middle eye

OMA or VMA

Optical or Voltage modulation amplitude

Level measurements
Mean

Mean value (volts or watts) of the measurements defining this signal level

RMS

Standard deviation of the measurements

PkPk

Range of the measurements

xxx

NOTE. Width and Height: For a BER specified as 1E-6, the Width and Height become EW6 and EH6, as
defined by OIF CIE 2014.230.
PAM4 global measurements

66

Measurement

Description

Ideal value

Minimum Signal Level

Half the smallest of the level separations

1/6 of peak–peak

Effective Symbol Level 1

Level linearity measure from Level0 and Level1

1/3

Effective Symbol Level 2

Level linearity measure from Level2 and Level3

1/3

Level Mismatch Ratio (RLM)

Minimum Signal Level relative to ideal Minimum Signal Level (if
levels were evenly spaced)

1

Level Deviation

Average deviation of level spacing from ideal spacing

0%

Level Thickness

Averaged, normalized level standard deviation at minimum
inter-symbol interference

0%

Level Time Deviation

Time deviations between levels measured at minimum inter-symbol
interference positions

0%
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PAM4 global measurements (cont.)
Measurement

Description

Ideal value

Vertical Eye Closure

Minimum eye amplitude loss

5 dB

OMA Outer or VMA Outer

Amplitude between Level0 and Level3

N/A

TDECQ

Transmitter and dispersion eye closure for PAM4

< 2.4 dB typical

ER

Extinction Ratio

3 dB- 10 dB range

AOP

Average Optical Power

N/A

xxx

Fast TDECQ test measurements definitions
Measurement

Description

Ideal value

TDECQ

Transmitter and Dispersion Eye Closure Quaternary

< 2.4 dB

OMA Outer

Optical Modulation Amplitude between PAM4 Level 0 and Level 3

ER

Extinction Ratio

AOP

Average Optical Power

xxx

Mask test measurement definitions
Mask test measurements

Description

PDF Hit Ratio Per Region
Overshoot

Measured hit ratio in the overshoot polygon

Center

Measured hit ratio in the center polygons

Undershoot

Measured hit ratio in the undershoot polygon

Results Over All Regions
PDF Mask Margin

Measured mask margin given a target hit ratio

PDF Hit Ratio

Measured hit ratio over all tested polygons given a target mask margin

BER Mask Margin

Measured mask margin given a target BER

BER Limit

Measured BER Limit given a target mask margin

Pass/Fail
Status

Pass or Fail given a target mask margin and either hit ratio or BER

Horizontal Shift

Amount the mask was shifted in time

xxx
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Rise, Fall measurements
Measurement

Description

Mean

Mean transition time

Standard Deviation

Standard deviation of the transition times

Coefficient of Variation

Standard Deviation divided by the Mean

Minimum

Minimum of the transition times

Maximun

Maximum of the transition times

Count

Number of transitions

xxx

NOTE. The Rise/Fall measurements for NRZ are on the Global tab.

Sample Count
Both results tables, Summary and Full Results are displaying the Sample Count of the data used for the
derivation of the measurements.
The Sample Count field represents the amount of statistical data acquired and analyzed, and contains the
full pattern acquisition, the jitter and noise characterizing data.
When in Free Run, the count is continuously incremented with the newly acquired and processed data.
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Steps to Acquire Data
To acquire data from acquisition channels and take measurements, follow these steps:
1. Select
to display the Acquisition dialog box and configure the application according to your
setup and signal type.
2. Select
to toggle the acquisition mode between free run (continuous) and single acquisitions and
processing cycles. When in Free Run mode, the following acquisition and processing continues
until you stop it:
acquisition and averaging of data-correlated patterns
acquisition, accumulation and statistical analysis of uncorrelated data
3. Select

to start the acquisition and processing cycle.

To stop the acquisition, do one of the following:
. This may
If you wish to stop the acquisition and processing cycle before it completes, select
be useful if you have started a sequence on a long waveform and then realize you would like to
change the configuration.
If you wish to interrupt the acquisition and processing cycle, select
resume the acquisition.

. Select a second time to

If you wish to halt a Free Run mode cleanly, toggle the Sequence
button. This will convert the
Free Run mode (indicated by the green button) to Single cycle mode (indicated by the blue button) so
that the acquisition stops when the cycle is complete. Single cycle is the default mode.
TIP. Use the Clear Data
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Saving and Recalling Setup Files
You can use the File menus to save and recall different oscilloscope and application setups. Setup files
store the oscilloscope and application settings.
CAUTION. Do not edit a setup file or recall a file that was not generated by the application.

See also:
Saving a Setup File (see page 70)
Recalling a Saved Setup File (see page 70)

Saving a Setup File
To save the 80SJNB application and oscilloscope settings to a setup file, follow these steps:
1. Select File > Save Settings to open the Save dialog box.
2. In the file browser, select the directory in which to save the setup file.
3. Use the keyboard to enter a new file name. The application appends a .stp extension to the file name.
4. Save the setup file. If the selected file name already exists, a confirmation dialog appears that allows
you to cancel the operation.
NOTE. The application saves the oscilloscope setup.

Recalling a Saved Setup File
To recall the application and oscilloscope settings from saved setup files, follow these steps:
1. Select File > Recall Settings to open the Recall dialog box.
2. In the Recall dialog box, select the directory from which to recall the setup file.
3. Select a setup file name, and then select Open.
CAUTION. Do not manually edit setup files. If you try to recall a setup file that was manually edited, the
recall operation fails.
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Saving and Recalling Data Files
You can use the File menus to save acquired data and then recall it later for analysis.
CAUTION. Do not edit a data file or recall a data file that was not generated by the application.

See also:
Saving a Data File (see page 71)
Recalling a Saved Data File (see page 71)

Saving a Data File
To save the data acquired by the 80SJNB application, follow these steps:
1. Select File > Save Data to open the Save dialog box.
2. In the file browser, select the directory in which to save the data file.
3. Use the keyboard to enter a new file name. The application appends a .mat extension to the file name.
4. Save the data file. If the selected file name already exists, a confirmation dialog appears that allows
you to cancel the operation.
NOTE. If the Acquisition Only mode is enabled, data is acquired from all available optical modules. When
selecting File > Save Data, you will save individual data files for each module.

Recalling a Saved Data File
To recall the acquisition data from saved data files, follow these steps:
1. Select File > Recall Data to open the Recall dialog box.
2. In the Recall dialog box, select the directory from which to recall the data file.
3. Select a data file name, and then select Open.
CAUTION. Do not manually edit setup files. If you try to recall a setup file that was manually edited, the
recall operation fails.
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About Working with Plots
You can display plots in a variety of layouts using the tool bar. One, two, or four plots can be displayed
in the toolbar. When displaying plots, the results data table
using the plot display buttons
changes to a summary table of data. To remove the plots entirely from the display, select the Show
Numeric Results button

on the tool bar.

If the plots have been removed from the display, redisplay the plots by either selecting one of the plot
display buttons or click the tab of the data table.

See also:
Plot Type Definitions (see page 72)
Functions in Plot Windows (see page 74)
About Exporting Plot Files (see page 74)
Selecting and Viewing Plots (see page 73)

Plot type definitions
Plot types are divided into the following categories:
Jitter: See Jitter Plots (see page 78) for a list of the types of jitter plots and their descriptions.
Noise: See Noise Plots (see page 81) for a list of plot types and descriptions.
Eyes: See Eye Plots (see page 79) for a list of plot types and descriptions.
Patterns: See Pattern Plots (see page 82) for a list of plot types and descriptions.
SSC: See SSC Plot (see page 82) for a description.
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Selecting and viewing plots
To select and view a plot, follow these steps:
1. Select one of the plot views

, (single plot, two plots, or four plots).

2. For each plot window, select a type of plot to display. Each plot display is based on the current analysis
results. Plots are updated as new results are acquired.
on the tab of the plot window. (Alternatively,
To select a plot type for display in the plot window, click
you can right-click anywhere on the existing plot display.) From the drop-down menu, use the Plot menu
to select a plot from the plot categories (Jitter, Noise, Eyes, Patterns, SSC).

When the target signal has a PAM4 coding scheme, plots will include the relevant information for each of
the three stacked eyes. The plots are color coded: yellow for eye0, green for eye1, and red for eye2.

See also:
About Exporting Plot Files (see page 74)
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Examining plots
You can examine plots in greater detail by either double-clicking in the plot window or selecting Examine
from the drop-down list in the plot window. Either of these actions launches a MATLAB plot window
which provides advanced tools to examine graphical displays of data.

See also:
MATLAB User Interface (see page 28)

About exporting plot files
There are two ways to export plot information from the 80SJNB application for use in other applications:
You can export the numerical data that is represented in the plot figure. This may be useful for
performing additional data processing.
You can create an image file that captures the current plot view. This is a useful way to document
your results.
The application offers the following choices from the drop-down list (right-mouse click over the selected
plot).

Plot lets you select a different plot to display in the window. The window displays the new plot
based on the acquired data.
Examine opens a MATLAB plot window which provides additional tools to more closely examine plot
characteristics.
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Copy Image saves the contents of the plot window as an image file.
Export saves the numerical values from the plot window in text or MATLAB format.
NOTE. Export plot functions are disabled whenever the application is actively sequencing.

See also:
Exporting Raw Plot Data (see page 76)
Exporting Plot Images (see page 75)
File Name Extensions (see page 17)

Copying plot images
You can copy the plot image displayed in any one of the plot windows. The copy is placed in the Windows
clipboard so you can paste the image into other Windows programs. This is convenient for creating
reports and engineering records to share with others.
To create an image file of a plot, follow these steps:
area of the plot window of the plot that you want to copy. (If using a mouse attached to
1. Tap the
the instrument, right-click anywhere within the plot window of the plot you intend to copy.)
2. Select Copy Image from the drop-down list. This copies the image to the Windows clipboard.

3. Open your destination program (such as WordPad or Paint) and paste the image into the application.

See also:
Exporting Raw Plot Data (see page 76)
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Exporting raw data
The 80SJNB provides the following methods to export raw data:
Export Waveform. Accessed from the File menu, exports the underlying acquired waveform and
correlated pattern data used for processing.
Export Results. Accessed from the File menu, exports the measurement results to a .csv text file that
can be opened in a spreadsheet tool.
Export. Accessed from the plot window, exports the data used to create the plot image. This method
allows access to any node along the signal path.

Export Waveform data
To export the waveform data used for processing, follow these steps:
1. Select File > Export Waveform > Correlated or File > Export Waveform > Acquired:

The Correlated waveform is the result of filtering the Acquired Waveform to eliminate uncorrelated
components (such as random and periodic jitter and noise).
The Acquired waveform contains the raw acquired pattern before any processing is done on it. (The
only processing on the raw data is interpolation for NULL points.)
2. Use the Export Waveform dialog box to specify the file name and path. The file name default
is “Correlated” or “Acquired” (depending on the selection), with the default file location at
Windows/Documents. Enter a new file name and/or directory location as needed.
3. Use the drop-down Save as type list to select the file type. The choices are:
Comma Separated Values (.csv): ASCII text that can be loaded into a spreadsheet. This is the
default selection.
MATLAB (.mat): Binary data in the native MATLAB 7.0 format.
4. Click Save.
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TIP. Binary files typically use about 40% more disk space than .csv files.

Export results
1. To export the measurement results to a .csv format text file, follow these steps:
2. Select File > Export Results.
3. Use the Export Results dialog box to set the file name and path. The file name default is “Results,”
with the default file location at Documents. Enter a new file name and/or directory location as needed.
4. Click Save.
All numeric results are exported. The following table shows some PAM4 numeric results as shown
in a spreadsheet.
.. .
Decision Threshold

0.1297174

–0.006247496

0.1474331

RJ(RMS)

3.71E-13

3.72E-13

3.71E-13

V
s

RJ(h)(RMS)

3.64E-13

3.63E-13

3.65E-13

s

RJ(v)(RMS)

7.24E-14

7.44E-14

6.92E-14

s

DJ

2.83E-11

3.17E-11

3.78E-11

s

DDJ

1.83E-11

2.78E-11

2.18E-11

s

DCD
.. .

9.50E-12

9.94E-13

1.53E-11

s

xxx

Export graph (plot) data
To export the numeric data used to create a specific plot, follow these steps:
area of the plot window of the plot you want to export. (If using a mouse attached to
1. Touch the
the instrument, right-click anywhere within the plot window that you want to export.)
2. Select Export from the drop-down menu.

3. Use the Export Graph dialog box to specify the file name and path. The file name default is “Graph,”
with the default file location at Windows/Documents. Enter a new file name and/or storage location
as needed.
4. Select the file type from the Save as type. The choices are:
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Comma Separated Values (.csv): ASCII text that can be loaded into a spreadsheet. This is the
default format.
MATLAB (.mat): Binary data in the native MATLAB 7.0 format.
Change in exported plot data with release 4.X. When exporting a .CSV file from the context menu of a
noise graph depicting RN PDF or RN*PN PDF, 80SJNB V4.X writes the columns in a different order
than was don in prior versions.
For all NRZ noise graphs, the data is exported in two columns:
Column 1: voltage at which the noise was measured
Column 2: probability of noise at the given voltage in the eye
Prior versions of 80SJNB (V3.X and earlier) swap these two columns when exporte the plot data.
For PAM4 plots, noise graphs are exported in four columns:
Column 1: voltage at which the noise was measured
Column 2: probability of noise at the given voltage in eye 0
Column 3: probability of noise at the given voltage in eye 1
Column 4: probability of noise at the given voltage in eye 2

See also:
Copying Plot Images (see page 75)

Jitter plots
Jitter plots
DDJ vs

78

Bit 1

Description
Data Dependent Jitter versus Bit displays the deviation of edge crossings at the user-specified
Decision Threshold for each bit of the entire pattern. The pattern itself is shown in the
background for cross reference. If the pattern is very long, the bits are visible only when
opening the graph with Examine.

DDPWS vs Bit 1

Data Dependent Pulse Width Shrinkage versus Bit displays the pulse width shrinkage for
each isolated one and zero in the pattern.

DDJ PDF

Data Dependent Jitter Probability Density Function is the histogram of the data pattern
correlated jitter, including Duty Cycle Distortion. The PDF is composed of the crossing
deviations at the user specified Decision Threshold of all edges of the data pattern.

DDJ Spectrum 1

The Data Dependent Jitter Spectrum is the result of the time domain to frequency domain
transformation of the series of crossing deviations of data pattern edges at the user specified
Decision Threshold.

RJ PDF

Random Jitter Probability Density Function shows the Gaussian distribution of the random,
unbounded, uncorrelated jitter component. It is computed from data acquired on a single
edge of the bit stream.
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Jitter plots

Description

PJ PDF

Periodic Jitter Probability Density Function represents the histogram of the uncorrelated,
bounded, periodic jitter component. It is computed by spectral separation of the jitter data
acquired on a single edge of the bit stream.

RJ*PJ Spectrum 1

Random and Periodic Jitter Spectrum represents the spectral distribution of the uncorrelated
jitter acquired on a single edge. The spurs represent the periodic jitter spectral lines, and the
rest of the evenly distributed spectral lines compose the random jitter spectrum.

RJ*PJ PDF

Random Jitter and Periodic Jitter Probability Density Function is the histogram of the
uncorrelated jitter data acquired on a single edge of the pattern.

DJ PDF

Deterministic Jitter Probability Density Function shows the distribution of the bounded jitter
component. The histogram is computed by convolving the DDJ PDF with the PJ PDF.

TJ PDF

Total Jitter Probability Density Function represents the computed histogram derived from all
jitter components, correlated and uncorrelated, bounded and unbounded. The convolution of
DJ PDF and RJ PDF yields the Total Jitter histogram.

BER Bathtub

The BER Bathtub curve is computed as a horizontal slice of the 3-dimensional BER Eye at
the Decision Threshold. It represents the extrapolated total jitter and horizontal eye opening
limits at projected bit error rates.

Q Bathtub

The Q-scaled curve is a linearized scale version of the BER Bathtub curve. It represents the
extrapolated total jitter and horizontal eye opening limits at projected bit error rates.

xxx

1

The zoom feature defaults to horizontal zoom only.

Eye plots
Eye plots

Description

Correlated Eye 1

The Correlated Eye is a color graded eye pattern built by folding the correlated pattern at
clock rates. The correlated pattern is computed from the acquired full length data pattern by
filtering out the uncorrelated components.

PDF Eyes

PDF Eye plots can be computed at various stages of the signal path emulator when using
the 80SJNB Advanced version. When using the Essentials version of the 80SJNB, all PDF
Eye plots are identical.
If a signal path component is not inserted into the signal path, the PDF Eye plot for the output
of the component is identical to the upstream PDF Eye plot. For example, if computing the
PDF Eye plot for the output of the Channel function, but the Channel function is not inserted
into the signal path, the PDF Eye plot will be identical to the PDF Eye plot of the output of the
Filter function.

SP In

The SP In PDF Eye is a color graded Probability Density Function representing the eye pattern
at the transmission side of the signal path. It is constructed from the convolution of the
Correlated Eye with uncorrelated jitter and noise probability distributions.

SP Filter 2

The SP Filter PDF Eye is a color graded Probability Density Function representing the
eye pattern at the output of the filter if the filter function is inserted in the signal path. It is
constructed from the convolution of the Correlated Eye with uncorrelated jitter and noise
probability distributions.

SP Channel 2

The SP Channel PDF Eye is a color graded Probability Density Function representing the eye
pattern at the output of the channel emulator if the Channel function is inserted in the signal
path. It is constructed from the convolution of the Correlated Eye with uncorrelated jitter and
noise probability distributions.
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SP Receiver PDF
Eye 2

Eye plots
Description
The PDF Eye is a color graded Probability Density Function representing the eye pattern at the
output of the Equalizer if the Equalizer function is inserted in the signal path at the receiver side
of the link. It is constructed from the convolution of the Correlated Eye with uncorrelated jitter
and noise probability distributions.
This selection was displayed as PDF Eye in 80SJNB application versions before version 2.1.

BER Eye 1

The BER Eye is a three-dimensional color graded map representing the predicted bit error
rates at all decision thresholds and sampling phases in the unit bit interval.

Q Eye 1

The Q Eye is a three-dimensional color graded map representing the predicted bit error rates
at all decision thresholds and sampling phases in the unit bit interval with a linearized Q-scale,
rather than the BER logarithmic scale.

BER Contour 1

The BER Contours show the boundaries of the eye opening at the projected bit error levels.

TDECQ Eye

The plot is a three-dimensional color graded map of the equalized eye diagram used for the
computation of TDECQ. When opened in Matlab (double click on the plot), it shows the vertical
slices on which the histograms are assessed.

xxx

1
2

80

Eye plot is computed at the end of the signal path, regardless of using the 80SJNB Advanced or Essentials version.
Tthe 80SJNB Advanced version (with Signal Path emulator) provides PDF Eye plots at the various stages (functions) of the emulator. If the function
is not inserted, the PDF Eye plot is identical to the upstream plot.
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Noise plots
Noise plots

Description

Bit 1

Data Dependent Noise versus Bit displays the data levels sampled at the user specified
Sampling Phase through the entire pattern. The pattern itself is shown in the background for
cross reference. If the pattern is very long, the pattern bits are visible only when opening
the graph with Examine.

RN*PN PDF

Random and Periodic Noise Probability Density Function is the histogram of the uncorrelated
noise distribution on data acquired on a single flat spot of logic level 1 of the bit stream.

RN PDF

Random Noise Probability Density Function shows the Gaussian distribution of the random,
unbounded, uncorrelated noise component. It is computed from data acquired on a single flat
spot of logic level 1 of the bit stream.

PN PDF

Periodic Noise Probability Density Function represents the histogram of the uncorrelated,
bounded, periodic noise component. It is computed by spectral separation of the noise data
acquired on a single flat spot of logic level 1 of the data stream.

DN PDF

Deterministic Noise Probability Density Function shows the distribution of the bounded noise
component. The histogram is computed by convolving the DDN PDF with the PN PDF.

DDN PDF

Data Dependent Noise Probability Density Function is the histogram of the data pattern
correlated noise distribution on both logic levels 1 and 0. It includes the data levels at all user
specified unit bit interval Sampling Phase.

TN PDF

Total Noise Probability Density Function represents the computed histogram derived from all
noise components, correlated and uncorrelated, bounded and unbounded. The convolution
of DN PDF and RN PDF yields the Total Noise histogram.

RN*PN Spectrum 1

Random and Periodic Noise Spectrum represents the spectral distribution of the uncorrelated
noise acquired on a single flat spot of logic level 1. The spurs represent the periodic noise
spectral lines, and the rest of the evenly distributed spectral lines compose the random noise
spectrum.

DDN Spectrum 1

The Data Dependent Noise Spectrum is the result of the time domain to frequency domain
transformation of the series of level samples taken on all bits at the user specified Sampling
Phase of the unit bit interval.

BER Bathtub

The BER Bathtub curve is computed as a vertical slice of the 3-dimensional BER Eye at the
user specified unit bit interval Sampling Phase. It represents the extrapolated total noise and
vertical eye opening limits at projected bit error rates.

Q Bathtub

The Q-scaled curve is a linearized scale version of the BER Bathtub curves. It represents the
extrapolated total noise and vertical eye opening limits at projected bit error rates.

DDN vs

xxx

1

The zoom feature defaults to horizontal zoom only.
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Pattern plots
Pattern plots can be computed at various stages of the signal path emulator when using the 80SJNB
Advanced version. When using the Essentials version of the 80SJNB, all Pattern plots are identical.
If a signal path component is not inserted into the signal path, the plot for the output of the component is
identical to the upstream plot. For example, if computing the pattern plot for the output of the Channel
function, but the Channel function is not inserted into the signal path, the pattern plot will be identical to
the pattern plot of the output of the Filter function.
Pattern plots

Description

SP_In 1

The Signal Path Input signal plots the correlated pattern at the transmission side of the Signal
Path, the input to the simulated serial link. The correlated pattern results when the acquired
pattern is filtered for the removal of the uncorrelated jitter and noise components. For closer
examination of the pattern, use Examine which provides pan and zoom capabilities, and
data cursors.

SP_Filter 1

The Signal Path Filter output plots the correlated pattern at the output of Filter, if the Filter
function is inserted in the signal path. The selected Filter file determines the effects of the Filter
function on the waveform. If the Filter function is not inserted in the signal path, The SP_Filter
displays the upstream waveform, in this case SP_In.

SP_Channel 1

The Signal Path Channel output plots the correlated pattern at the output of the Channel
emulator if the Channel function is inserted in the signal path. The selected S-parameter or
time domain waveform set determines the attributes of the signal at the output of Channel.
If the Channel function is not inserted in the signal path, SP_Channel displays the upstream
waveform which could be the SP_Filter or SP_In function of signal path configuration.

SP_Equalizer 1

The Signal Path Equalizer output plots the correlated pattern at the output of the Equalizer if
the Equalizer function is inserted in the signal path at the receiver side of the data link. The
configuration of tap numbers and tap values determines the attributes of the equalizer and
shapes the signal at the output. If the Equalizer function is not inserted, SP_Equalizer plot
displays the upstream signal which could be any of the previous patterns, depending on the
signal path configuration.

xxx

1

The zoom feature defaults to horizontal zoom only.

SSC plot
SSC plot
SSC

Profile 1

Description
The Spread Spectrum Clocking profile displays the function used for modulating the serial link
clock frequency. If the “SSC is present” check box is checked in the Acquisition setup dialog,
the profile plot is displayed.

xxx

1
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The zoom feature defaults to horizontal zoom only.
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Working with numeric results
After an analysis is complete, you can display the results as numeric data in either a summary or detailed
(full) table. Use the View menu in the file menu bar to select how to display the data. A summary of data
allows room to display the plots while the full results replaces the plot display entirely.
In both the summary and detailed views, the numeric panel has three or six tabs depending on the Coding
(NRZ or PAM4).

The summary selections list the noise and jitter measurements but not the breakdown of the measurements.
The results tabs display relevant jitter or mask test results.

Selected eye tab detail tables show more detail, as shown in the following:
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Eye tabs (both NRZ and PAM4)

Mask tabs (both NRZ and PAM4)

Global tab for NRZ

84
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Global tab for PAM4

Rise/Fall tab (PAM4 only)

NOTE. If it happens that the specified reference levels are not crossed for at least one transition, the only
statistic reported is the minimum of the measurements for that transition.
You can easily switch between summary and detailed numeric displays by clicking the numeric results
button

and the plot window buttons

.

Click on a results tab to display the results. The active tab is indicated by magnified label text.

NRZ results tabs
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PAM4 results tabs
To hide the summary table and provide more room for the plot displays, click the displayed tab. Click the
tab again to show the summary data table.
Here you can see that the plot windows fill the entire screen and the numeric result tabs are at the bottom
of the screen.

NRZ plots and results tabs
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PAM4 plots and results tabs

TDECQ Eye plot

See also:
Working with Plots (see page 72)
Noise Measurement Definitions (see page 65)
Jitter Measurement Definitions (see page 64)
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SSC Modulation Measurement Definitions (see page 65)

An application example
The following example uses the 80SJNB application on an optical signal for fast analysis of BER, Jitter,
and Noise. This simplified application example shows how to configure and use the application. This may
help you when setting up your own test situation.
Requirements:
DSA8300 oscilloscope
80SJNB software
ADVTRIG Advanced Trigger Option installed
Optical module with clock recovery. The following example uses the 80C11-CR4 Optical Sampling
Module.
SMA cables

Set up the oscilloscope
1. Install the modules and make the signal connections (the example assumes using channel 1 as the
signal source).
2. Turn on the instrument and wait for instrument and application startup to complete.
3. Push the Default Setup front panel button.
4. Select Channel 1.
5. Push the SETUP DIALOGS button.
6. Click the Horz tab.
7. Set the Horizontal scale to 5 ns.
8. Click the Mode/Trigger tab.
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9. Verify that Trigger Source is set to Clock and select C1 Clock Recovery as the clock source.
10. Click the Pattern button in the Scope Mode (Clock Trigger Source) area.
11. Click the Pattern Sync/FrameScan Setup button.

12. Enter the Data Rate parameter (for example, 9.8 Gbps).
13. Set the Pattern Length parameter (for example, 127 bits).
14. Click Close.
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NOTE. You should now have a stable signal display on the DSA8300. If not, recheck all settings, signal
source, and connections. The 80SJNB application requires a stable signal to acquire data for accurate
measurements.

Set up the 80SJNB application
1. Click Applications > 80SJNB in the DSA8300 menu to start the 80SJNB application.

You can also use the Windows 80SJNB desktop shortcut or the Windows Start menu Start > Programs >
Tektronix Applications > 80SJNB > 80SJNB to start the 80SJNB application.
1. Wait for the 80SJNB application to finish loading.
2. Click the Acquisition button (

) to open the acquisition dialog box.

3. Most of the configuration settings are already filled in, as the 80SJNB application acquired the values
from the oscilloscope configuration. If not, click the AutoSync to Selected Waveform button to sync
the Source, Data Pattern, and Pattern Sync settings to the oscilloscope.
Since this is an optical signal and we’re using the clock recovery signal, you’ll need to select the
optical signal filter and select the clock recovery settings.
The setup in this example does not include a Phase Reference module, so this field is grayed out.

Click OK to apply the settings and close the dialog box.
4. Click

90

to start the acquisition and processing cycle.
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While the cycle is running, you’ll see the sequence of events displayed at the bottom of the application
display. When the cycle is complete, the application displays the message “Analysis Complete.”
5. Once the cycle is complete, you’ll see the displayed results. The example below shows a four plot
display with the summary table of the numerical results.

Working with the results
1. Click

to minimize the plot displays and show the detailed results table.

2. Redisplay the plot (or plots) by selecting one of the plot display buttons

.

Click the JNB Results tab to minimize the detailed list to a summary list.
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3. With the plots now redisplayed, click the Configure Plot icon (
) on the plot tab to display a
drop-down menu for that plot. The menu provides several functions, one of which is to select a
different type of plot to display in that window.

You can select any plot type. The plot is displayed based on the data based on the results of the
last processing cycle.
4. To further examine a plot, you can display any plot in a MATLAB window, providing you with more
tools to work with the data. Click the Configure Plot (

) icon and choose Examine.

The plot opens in a new window to provide further data analysis and visualization of the plot displays.
MATLAB provides multiple capabilities to display and annotate the plot diagrams, including:
Pan and Zoom
2D and 3D visualization
Rotation
Data Cursors
Color enhancements
The following figure shows a 3D BER Eye plot using the rotate function.
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Close the window to return to the 80SJNB display.
This is the end of the example. You can continue on by acquiring new data, displaying various types of
plots, and examine the plots with the various tools available.
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About application parameters
These topics list the 80SJNB application parameters and include the menu default settings. The parameter
tables list the selections and startup values for each option.
Analysis Settings (see page 95)
Acquisition Settings (see page 97)
Signal Path Settings (see page 98)
Mask test settings (see page 99)
Refer to the GPIB topics for a list of the GPIB Command Syntax with the arguments, variables, and
variable values that correspond to the 80SJNB parameters.
You should refer to the documentation for your TekScope for operating details of the oscilloscope controls.

See also:
GPIB Reference Materials (see page 103)

Analysis settings
This table lists the default Analysis settings when the 80SJNB application is first started. If you change
these settings, they remain in effect for all successive sessions of the application.
Control

Startup settings

Method

Spectral + BUJ

Decision Threshold

Normalized: 50%

Time Unit

Seconds

Sampling Phase

Unit Intervals: 0 UI

Global BER

1.00E-12

JxBER

2.5E-3

JyBER

2.5E-10

Rx Optimizer for NRZ

Optimize Receiver

Rx Optimizer for PAM4

Optimize to Center Eye (Common Phase) according to OIF or IEEE specifications

ER Correction Factor

0%

Compute TDECQ

unchecked

Histogram Width

4 % UI

Compute Rise/Fall Times
checkbox

unchecked

TDECQ Extended Analysis

unchecked
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Control

Startup settings

Adaptive Threshold Adjustment

unchecked

Rise/Fall Low %

20

Rise/Fall High %

80

xxx
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Acquisition settings
This table lists the default Acquisition settings when the 80SJNB application is first started. If you change
these settings, they remain in effect for all successive sessions of the application.
Control

Startup settings

Signal
Source

First valid input channel

Coding

NRZ

Fast TDECQ Acquisition Mode

Not Checked

Difference Waveform
Positive

First valid input channel

Negative

blank

Data Pattern
Samples per UI

5, 10, 20, 40, or 100

Rate

User defined

Pattern Length

User defined

Stop on Condition

Never

Scope Setup Recall On Exit

Checked

Signal Conditioning
Wavelength

None

Filter

None

Bandwidth

blank

Scope Noise

4 μW

Pattern Clock
Source

CLOCK INPUT/PRESCALE TRIGGER front panel connector

Recovery Rate

blank

Phase Reference
Source

None

Frequency

blank

SSC is present

Not checked

xxx
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Signal path settings
This table lists the default Signal Path settings when the 80SJNB application is first started. If you change
these settings, they remain in effect for all successive sessions of the application.
Control

Startup settings

Filter
Uncorrelated Scaling

1.00

Channel
Data Type

Frequency Domain

Uncorrelated Scaling

1.00

Equalizer
CTLE

None

Taps
FFE Taps

1

FFE Taps/Symbol

1

DFE Taps

0

Options
FFE Reference Tap

1

Uncorrelated Scaling

1.00

Rise Time Selector

Track Data Rate

User Rise Time (ps)

200

xxx
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Mask test settings
This table lists the default Mask test settings. If you change these settings, they remain in effect for all
successive sessions of the applications.
Control

Startup settings

Mask Test Definition
Mask File

None

Load browser

C:\Users\Public\Documents\Tektronix\Masks

Save browser

C:\Users\Public\Documents\Tektronix\Masks

Rate

10 Gbps

Target Hit Ratio

5.00E-005

Target Mask Margin

0

Target BER

1.00E-005

Horizontal Autofit

unchecked

Runtime Options
Test Target

SP Receiver PDF Eye

Find Mask Margin

selected

Measure Hit Ratio

unchecked

Measure Hit Ratio

disabled

DUT Pass/Fail Test

unchecked

All Polygons

checked

Center Polygons Only

unchecked

Enable Mask Testing

unchecked

xxx

Mask file structure
Tektronix mask files have a .msk file extension and are in XML format. This table describes each field.
XML element

Description

Status

<?xml version="1.0" encoding="utf-8"?>

Standard xml header

Required

<Tektronix>

Root node of the file

Required

FileVersion> Version x.y.z </FileVersion>

Version of the file

Required

<FileCreated>mm/dd/yyyy hh:mm:ss [AM|PM]</FileCreated>

Date and time the file was created

Required

<StandardName>StandardName</StandardName>

Name of the standard in this file

Required
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XML element

Description

Status

<StandardVersion>StandardVersion</StandardVersion>

Version of the standard in this file

Required

<StandardDate>StandardDate</StandardDate>

Date of the standard for this file

Required

<StandardSub>Sub</StandardSub>

Additional standard subdivisions

Optional

<StandardData>

Data specific to the standard used for
multiple sub-elements

Required

<SymbolRate>SymbolRate</SymbolRate>

Data (symbol) rate for this standard
[numeric]

Required

<ModulationScheme>PAM4</ModulationScheme>

Modulation scheme for this standard
[NRZ/PAM4]

Required

<Pattern>PRBS-7</Pattern>

Data pattern for this standard

Optional

</StandardData>

Close for StandardData

Required

<MaskTest>

Identifies a mask test set of elements

Required

<UIReadoutString>ReadoutString</UIReadoutString>

String displayed in the mask readout
area (ex: SATA G2 Tx)

Required

<UISelectionString>SelectionString</UISelectionString>

String displayed in the selector or
menu (ex: SATA G2 Tx (3.0 Gb/s))

Required

<PIToken>PIToken</PIToken>

String for standard selection from the
PI (ex: ATATXG2)

Required

<TestParameters>

Standard specified parameters
related to the mask

Optional
Optional

<TargetHitRatio>TargetHitRatio</TargetHitRatio>
<TargetHits>TargetHits</TargetHits>

Target number of hits for this standard
[numeric] (ex: 100)

Optional

<UnitIntervalSamples>UIS</UnitIntervalSamples>

Required number of UI samples for
this standard [numeric] (ex:1000000)

Optional

TargetBER>TargetBER</TargetBER>

Target BER for this standard [numeric]
(ex: 1e-12)

Optional

<BERTargetEnabled>bool</BERTargetEnabled>

Whether Target BER is used
[True/False]

Optional

<HorizontalAdjustAllowed>bool</HorizontalAdjustAll-

Whether horizontal adjustment of the
mask is allowed during testing

Optional

<VerticalAdjustAllowed>bool</VerticalAdjustAllowed>

Whether vertical adjustment of the
mask is allowed during testing

Optional

</TestParameters>

Close for TestParameters

Optional

<Mask>

Identifies a set of mask polygons

Required

<Name>Rx Mask</Name>

Name of this mask

Optional

<MaskType>MaskType</MaskType>

Type of mask: Relative | Absolute

Required

owed>
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XML element

Description

Status

<VerticalScale>VerticalScale</VerticalScale>

Vertical scale to use if mask is
absolute [numeric]

Required

<PolygonGroup>

Groups of polygons for this mask

Required

<Name>GroupName</Name>

Name for this polygon group

Optional

<NumPolygons>n</NumPolygons>

Number of polygons in this group
[numeric ≥1]

Required

<Polygon0>

First polygon definition

Required

<Name>PolygonName</Name>

Name of this polygon

Optional

<PolygonType>Overshoot</PolygonType>

Overshoot, Center, or Undershoot

Required

<Symmetry>VerticalAxisReflection</Symmetry>

HorizontalAxisReflection,
VerticalAxisReflection,
BothAxesReflection or None

Required

<NumVertices>m</NumVertices>

Number of vertices in this polygon
[numeric]

Required

<PointX0>p</PointX0>

X value for the first vertex [numeric]

Required

<PointY0>p</PointY0>

Y value for the first vertex [numeric]

Required

<PointX1>p</PointX1>

X value for the second vertex
[numeric]

Required

<PointY1>p</PointY1>

Y value for the second vertex
[numeric]

Required

...

Additional vertices as needed

Optional

</Polygon0>

Close for Polygon0

...

Additional polygons as needed

Optional

Close for PolygonGroup

Required

Close for Mask

Required

</MaskTest>

Close for MaskTest

Required

<Source>

Specification data for sources for this
standard

Optional

Source amplitude specification for
this standard

Optional

Close for Source

Optional

Close for Root

Required

</PolygonGroup>
</Mask>

<Amplitude>A</Amplitude>
</Source>
</Tektronix>
xxx
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Notes:
MaskType: For Relative masks the X and Y coordinates of Center polygons are in the range [0-1],
this being both the horizontal and vertical ranges of a unit interval.
PolygonType: A mask can have at most one Undershoot polygon and one Overshoot polygon. A
PAM4 mask will usually have 3 Center polygons.
Symmetry: This field for a polygon is an indicator for a polygon editor as to the symmetry imposed
on the polygon by the standard. It is up to the polygon editor to enforce this.
NumVertices: This field for a polygon must be at least 2 for an Overshoot or Undershoot polygon
and at least 3 for a Center polygon.
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Remote control introduction
The 80SJNB software application can be controlled programmatically through the programmatic interface
of the sampling oscilloscope on which it is running. Communication with the application is accomplished
using VARIABLE:VALUE remote GPIB commands.
Your program should comply with the following guidelines:
The application startup must complete before sending additional GPIB commands to the application.
Querying the variable “Application” returns “80SJNB” when the application startup is complete.
The measurements cycle must complete before you query data. Querying the variable DataReady
returns “True” when the data is ready.
Because the oscilloscope software hosts the GPIB interface for the 80SJNB application, there is some
additional information that is helpful for successful programming.

See also:
GPIB Reference Materials (see page 103)
Programming Tips (see page 104)
Variable:Value Commands (see page 106)
Results Queries (see page 119)
Programming Examples (see page 125)

GPIB reference materials
To use GPIB commands with your TekScope, you can refer to the following materials:
The Programming Examples (see page 125) topic for guidelines to use while designing a GPIB
program.
The Programmer Guide for the TekScope.

See also:
Starting and Setting Up the Application Using GPIB (see page 103)
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Programming tips
Launching 80SJNB
Use the following command (issued for the DSA8300 instrument) to launch the 80SJNB application:
APPLICATION:ACTIVATE "80SJNB Advanced"

How the variable value table works
Programmable Interface (PI) commands for the 80SJNB software package (JNB) are implemented using
a variable|value table. This table associates named variables with text values. These values can be set
(variable:value “VariableName”,”VariableValue”) or queried (variable:value? “VariableName”) from the
PI. When a set command is received, if the variable does not already exist in the table, it is created and the
specified value is associated with that variable. If the variable is already in the table, the specified value
will replace the existing value. There is no checking done by the table on variable names or values. Since
both items are strings, any arbitrary pair of strings can be associated with each other in this table.

Polling and limit of variable values
Each time a change is made to a variable’s value in the table, an event is generated. The 80SJNB software
application polls the oscilloscope software application every 200 ms to see if an event occurred. If so, JNB
queries for the event information which tells JNB which variable changed and the new value. JNB parses
this information to find the variables pertinent to its operation and reads the new values for those variables.
These new values can change the state of JNB (for example selecting a new data source channel) or can
cause JNB to perform an operation (for example, setting “SequencerMode” to “Run”).
Because JNB polls for changes at a fixed rate, the oscilloscope application might indicate that a list of
variables has changed since the last time JNB polled for changes. There are two consequences of this
operation.
First, when JNB receives a list of changes, it does not necessarily execute those changes in the order in
which they were sent to the oscilloscope from the PI. This means that sending a command to change
the data source (for example, “DataSource”,”C1”) followed immediately by starting sequencing
(“SequencerState”,”Run”) does not guarantee that the source channel is changed before JNB begins
the sequencing operation. To be sure of proper execution order of these commands, a delay of at least
400 ms should be inserted before starting certain JNB operations.
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Commands that should be preceded by a delay include:
“SequencerState”,”Run”
“ExportCurve”,”GO”
“SaveRecallData”,”Save”
“SaveRecallData”,”Recall”
“Setup”,”Save”
“Setup”,”Recall”
Second, there is a limit of 15 variable/value table changes that can be reported for any one polling
event. If more than 15 changes have occurred between JNB polls of the oscilloscope software, the
later changes will not be seen by JNB so it will not respond to those commands.
The following list specifies which commands require the PI program to query for the Done status - that
is, the command execution is complete. Wait (loop in query command) until Done or Error is returned
before proceeding with the command sequence.
Application
Clear
EqAutosetTaps
EqDefaultDFETaps
EqDefaultFFETaps
EqLoadTaps
EqSaveTaps
ExportCurve
ExportResults
PrintToFile
SaveRecallData
Setup
SpCompute

How the variable value table is updated
JNB only updates table entries when it has new data to report. For example, if an error occurs during
sequencing, the variables “ErrorCode” and “ErrorMessage” are updated by JNB with the appropriate
values. However, JNB will only update those variables if another error occurs. If a subsequent sequence is
run without errors, the “ErrorCode” and “ErrorMessage” variables will continue to report the old values.
The user program must be written to explicitly clear these variables, setting the variables to null strings
(“”) before starting a new sequence.
Variables that should be set to null strings (“”) before starting a sequence operation include:
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ErrorCode
ErrorMessage
DataReady

Determining if 80SJNB is running
The “Application” variable shows whether 80SJNB is running or not. When it is running, this variable is
set to “80SJNB”. When JNB exits normally, the variable is set to “Done”. However, if JNB encounters an
error and exits abnormally, it will not set the “Application” variable to “Done”, leaving the variable set
to “80SJNB”. In this circumstance, it is not possible to use this variable to determine if JNB is running.
One way to reliably determine if JNB is running is to set the “PatternLength” variable to “1”. If JNB is
running, it will set this variable to “2” since 2 is the minimum allowable value for “PatternLength”. If JNB
is not running, the variable value will remain at “1”. Be sure to wait at least 400 ms after setting the value
to “1” before querying the status of this variable.

Syntax
The VARIABLE:VALUE command accepts string arguments for a control or data variable and a value
to which to set the argument.
To set a variable to a value, use the syntax:
VARIABLE:VALUE "<variableName>","<variableValue>"

For example, the following commands set the signal source channel, data rate, and pattern length to
be analyzed.
VARIABLE:VALUE
VARIABLE:VALUE
VARIABLE:VALUE
VARIABLE:VALUE

"DataSource","CH1"
"DataRate","10.3125e9"
"PatternLength","32767"
"SamplesPerBit","40"

To query the value in a variable:
VARIABLE:VALUE? <variablename>

For example, the following commands query the state of the acquisition and processing cycle.
VARIABLE:VALUE? "DataReady"
VARIABLE:VALUE? "SequencerState"

NOTE. The arguments <variableName> and <variableValue> are required in the order indicated with no
spaces allowed.
NOTE. Commands are case and space sensitive. Your program will not operate correctly if you do not
follow the capitalization and spacing precisely.
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See also:
Variable:Value Command Arguments and Queries (see page 107)
GPIB Commands Error Codes (see page 125)
Programming Examples (see page 125)

Variable name arguments and queries
Programming Examples (see page 125)
Variable name

Value

Function

Query form returns

AcqCycleCount

Positive integer number
larger than 2

Sets or returns the acquisition
cycle count

Current value

AcqOnlyChannelID
(Query only)

{CH1 | CH2 | CH3 | CH4}

Returns the identity of
available optical channels as
a string

CH1, CH2, CH3, or CH4

AcqOnlyHWfilter

Any valid communication
standard as defined by the
source module

Sets or returns the
communication standard
for all source modules

Current value
The list of tokens for the
selection of a specific
hardware filter is specified in
the DSA8300 Programmer
Manual. Please use the
manual for cross-reference of
the optical hardware filters.

AcqOnlyMode

{True | False}

Enable fast acquisition
mode on all optical channels
available

True or False

Returns module type as string

80C10, 80C17, 80C18,
80C20, or 80C21 as a string

Sets or returns the noise of
the acquisition channel

Current value

Returns module serial
number

A string characterizing the
module serial number

AcqOnlyModuleType
(Query only)
AcqOnlyScopeNoise

A valid positive floating point
value

AcqOnlySerialNum
(Query only)
AnalysisMethod

{CDF | Spectral}

Sets the jitter and noise
analysis method. Spectral
is legacy. Default is CDF
(Cumulative Distribution
Function)

Current value

Application

Exit

Exits the application

Done
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Application (Query only)
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Function

Query form returns

Returns which application is
running

"80SJNB" if the application
is running, or "Done" if
application has exited.
Wait for Done or Error before
proceeding

Bandwidth

Any valid bandwidth as
defined by the selected
source module

Sets or returns the bandwidth
in Hertz for use when Filter is
set to None

Current value

BER

Any valid floating point
value between 1e-3 and
1e-24 inclusive

Sets or returns the current
BER value

Current value

BWEcreateFromSparam

{True | False}

User option to create
a BWE filter from the
BWESparamFilename
and specified bandwidth
frequencies

True or False

BWESparamFilename

Full path name of an
S-parameter file name

Defines the channel
S-parameters to be used
for a BWE filter creation

Current value

CeActive

{True | False}

Activates or deactivates the
channel emulator

True, False

CeDomain

Time | Frequency

Sets the domain in which the
channel characteristics are
defined

Current value

CeFdSParametersFile

Full path name of a file name

Defines the channel’s
S-parameter

Current value

CeFd2PortMatrixSelector

{11 | 12 | 21 | 22}

Selects an S-parameter when
using a 2-port Touchstone file

Current value

CeFd4PortDataType

{SingleEnded | Differential}

Selects the type of data when
using a 4-port Touchstone file

Current value

CeFd4PortLayout

{DC21 | CD21 | 12DC | 12CD}

Sets the data arrangement
used by a 4-port Touchstone
file containing Differential
data

Current value

CeFd4PortMapping

Any permutation of 1234
(for example, 1234, 1324 or
2143)

Sets the port mapping used
by a 4-port Touchstone file
containing SingleEnded data

Current value

CeTdReferenceFile

Full path name of a file name

Defines the time domain
reference waveform

Current value

CeTdTransmissionFile

Full path name of a file name

Defines the time domain
transmission waveform

Current value
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Variable name

Value

Function

Query form returns

CeUncorrelatedScaling

Any number in the range
0.01-100.0

Sets the Channel
uncorrelated scaling factor
Overall signal path
uncorrelated scaling factor
is a product of all active
uncorrelated scaling values

Current value

ClockRecoveryRate

Valid values include any
communication standard
token for communication
standards supported by the
clock recovery module or a
positive floating point value
if the clock recovery unit
supports user rates

Sets or returns the clock
recovery rate

Current value

ClockSource

{ClockPrescale |
C1ClockRecovery |
C1CRClockPrescale
| C3ClockRecovery |
C3CRClockPrescale}

Sets or returns the clock
source

Current value

Coding

NRZ | PAM

Sets the coding scheme of
the signal

Current value

ComputeRiseFallTimes

{True | False}

Sets whether rise/fall times
will be computed as part of a
run

True or False

ComputeTDECQ

{True | False}

Enables the computation
of the Transmitter and
Dispersion Eye Closure
Penalty for PAM4

True or False

CreateBWE

{True | False}

Activates BWE filter creation

True or False

CTLE1ADC

Any valid positive floating
point value

Sets the ADC value for stage
1 of the CTLE

Current value

CTLE1FPole1

Any valid positive floating
point value

Sets the frequency of the first
pole of the filter for stage 1

Current value

CTLE1FPole2

Any valid positive floating
point value

Sets the frequency of the
second pole of the filter for
stage 1

Current value

CTLE1FZero

Any valid positive floating
point value

Sets the frequency of the
zero of the filter for stage 1

Current value

CTLE1Include

{True | False}

Sets whether stage 1 should
be included in the filter

True or False

CTLE1Standard

Index in the UI combo box;
out of range values have
same effect as 0

Select the standard for stage
1

Current value
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Variable name

Value

Function

Query form returns

CTLE1Use2Poles

{True | False}

Sets whether to use 1 or 2
poles for stage 1

True or False

CTLE2ADC

Any valid positive floating
point value

Sets the ADC value for stage
2 of the CTLE

Current value

CTLE2FPole1

Any valid positive floating
point value

Sets the frequency of the first
pole of the filter for stage 2

Current value

CTLE2FPole2

Any valid positive floating
point value

Sets the frequency of the
second pole of the filter for
stage 2

Current value

CTLE2FZero

Any valid positive floating
point value

Sets the frequency of the
zero of the filter for stage 2

Current value

CTLE2Include

{True | False}

Sets whether stage 2 should
be included in the filter

True or False

CTLE2Standard

Index in the UI combo box;
out of range values have
same effect as 0

Select the standard for stage
2

Current value

CTLE2Use2Poles

{True | False}

Sets whether to use 1 or 2
poles for stage 2

True or False

CurrentTab

0 – PAM Global
1 – Eye0 / JNB Results
2 – Eye1
3 – Eye2
4 – Mask

Sets the number of the tab to
display

Current value

DataRate

Any valid positive floating
point value or communication
standard

Sets or returns the expected
data rate

Communication standard or
current value

DataReady

{True | False}

Sets or returns a value
indicating if sequencing is
complete and data is ready to
be read
Setting this value to False
before beginning a sequence
prevents accidentally reading
the DataReady value from a
previous sequence before it
is reset by the application

True, False

DataSource

{CH1 | CH2 | CH3 | CH4 |
CH5 | CH6 | CH7 | CH8 |
MATH1 | MATH2 | MATH3 |
MATH4 | MATH5 | MATH6 |
MATH7 | MATH8 | <file name
>}

Sets or returns the data
source
Math expressions must be
programmed through the
oscilloscope GPIB interface
commands

Current value
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Variable name

Value

Function

Query form returns

DecisionThresholdAbs
DecisionThresholdAbs1
DecisionThresholdAbs2

Any valid floating point value

Sets or returns the absolute
decision threshold value of
eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1
or 2

Current value as set by user;
actual value used will differ if
the Optimizer is both enabled
and successful; see PI query
DecisionThresholdEff

DecisionThresholdPct
DecisionThresholdPct1
DecisionThresholdPct2

Any valid floating point value
between 0.0 and 1.0 inclusive

Sets or returns the normalized
decision threshold value of
eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1
or 2

Current value as set by user;
actual value used will differ if
the Optimizer is both enabled
and successful; see PI query
DecisionThresholdEff

DecisionThresholdUnits

{Absolute, Normalized}

Sets or returns the desired
decision threshold value to
use
By setting the units
to Absolute, the
DecisionThresholdAbs value
is used. If the units are set
to Normalized, the decision
threshold is calculated based
on waveform data according
to the DecisionThresholdPct
normalized value.

Current value

EqActive

{True | False}

Activates or deactivate the
equalizer

True or False

EqAutosetTaps

{Run}

Automatically computes the
equalization coefficients
SpCompute must be run first

Current value or Done, Error
Wait for Done or Error before
proceeding

EqDFETaps

An integer in the range 1-40

Sets the number of DFE taps

Current value

EqDFETapCoefficient<n>
where <n> is in the range
1–40

Any number in the range
-100.0 to +100.0

Sets the value of a DFE tap
coefficient

Current value

EqDefaultDFETaps 2

{Run}

Sets the DFE taps to default
values

Current value or Done, Error
Wait for Done or Error before
proceeding

EqDefaultFFETaps 2

{Run}

Sets the FFE taps to default
values

Current value or Done, Error
Wait for Done or Error before
proceeding

EqFFEReferenceTap

An integer in the range 1 –
EqFFETaps

Selects the FFE reference
tap
EqFFEReferenceTap-1 must
be an integer
(possibly 0) multiple of
EqFFETapsPerSymbol

Current value

EqFFETaps

An integer in the range 1-100

Sets the number of FFE taps

Current value
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Function

Query form returns

EqFFETapsPerSymbol

One of 1, 2, 5, 10 but not
larger then EqFFETaps

Sets the number of FFE taps
per symbol or unit interval

Current value

EqFFETapCoefficient<n>
where <n> is in the range
1–100

Any number in the range
-100.0 to +100.0

Sets the value of an FFE tap
coefficient

Current value

EqLoadTaps 2

{Run}

Loads the equalizer
configuration from a file

Current value or Done, Error
Wait for Done or Error before
proceeding

EqRiseTimeSelector

{DataRate | TapInterval |
User}

Defines how the equalizer
rise time is determined

Current value

EqSaveTaps 2

{Run}

Saves the equalizer
configuration to a file

Current value or Done, Error
Wait for Done or Error before
proceeding

EqTapsFilename

Full path name of a file

Sets the file used
for EqLoadTaps and
EqSaveTaps

Current value

EqUncorrelatedScaling

Any number in the range
0.01-100.0

Sets the Equalizer
uncorrelated scaling factor
Overall signal path
uncorrelated scaling factor
is a product of all active
uncorrelated scaling values

Current value

EqUseCTLEFilter

{True | False}

Sets whether to use the filter

True or False

EqUserRiseTime

An integer in the range
1-4000

When EqRiseTimeSelector is
set to User, this defines the
rise time in picoseconds

Current value

ERcorrFactor

An integer in the range -99 –
100%. Default is 0% of ER
measurement

Compensates for optical
offsets and drift

Current value

ErrorCode

Returns a numeric code
corresponding to the last
error or 0 if no error

Current value

ErrorMessage

Returns the last error
message

Current value

{GO}

Sets or returns the export
action

Current value or Done, Error
Wait for Done or Error before
proceeding

ExportFilename

<file name > 1

Sets the file name used when
exporting data

ExportFormat

{CSV, MAT}

Sets or returns the current
plot diagram export format

ExportCurve 2
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Variable name

Value

Function

Query form returns

ExportResults

{GO}

Initiates the export results
action to the file specified by
ExportFilename

Export action status: Done or
Error
Wait for Done or Error before
proceeding

ExportType

ACQWFM | CORRWFM,
RJPDF | PJPDF | RJPJPDF
| RJPJSPEC | DDJPDF |
DJPDF | DDJSPEC | TJPDF
| DDJ | HBATH | QHBATH |
RNPDF | PNPDF | RNPNPDF
| RNPNSPEC | DDNPDF |
DNPDF | DDNSPEC | TNPDF
| DDN | VBATH | QVBATH |
BEREYE | QEYE | PDFEYE |
CORREYE | BERCONTOUR
| SPCHANPDFEYE |
SPCHANWFM | SPFILTWFM
| SPFILTPDFEYE |
SPINPDFEYE | SPINWFM |
SPEQWFM | SSCPROFILE

Sets or returns the type of
export to perform

Current value

EyeGraphSelection

Integer from 0 to 7

Specifies which eye graphs
to display in plots having one
graph per eye. Bit N is for
eye N, where N is 0, 1 or 2.

Current value

FiActive

{True | False}

Activates or deactivates the
filter

True, False

FiFilename

Full path name of a file name

Defines the filter file

Current value

FiUncorrelatedScaling

Any number in the range
0.01-100.0

Sets the Filter uncorrelated
scaling factor
Overall signal path
uncorrelated scaling factor
is a product of all active
uncorrelated scaling values

Current value

Filter

Any valid communication
standard as defined by the
selected source module

Sets or returns the
communication standard
of the source

Current value
The list of tokens for the
selection of a specific
hardware filter is specified in
the DSA8300 Programmer
Manual. Please use the
manual for cross-reference of
the optical hardware filters.

GraphMode

1, 2 or 4

Sets the number of graphs to
display.

Current value

GraphSelection1

name of graph to display 4

Sets or returns the graph in
box 1

Current value
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Value

Function

Query form returns

GraphSelection2

name of graph to

display 4

Sets or returns the graph in
box 2

Current value

GraphSelection3

name of graph to display 4

Sets or returns the graph in
box 3

Current value

GraphSelection4

name of graph to display 4

Sets or returns the graph in
box 4

Current value

MaskFilename

path+name

Sets or returns the mask file
being used

Current file

JxBER

Any valid floating point value
between 1e-3 and 1e-24
inclusive

Sets the Jx auxiliary BER
value

Current value

JyBER

Any valid floating point value
between 1e-3 and 1e-24
inclusive

Sets the Jy auxiliary BER
value

Current value

LimitBWforBWE

Any valid positive floating
point value

Sets the frequency limit for
the BWE filter to be created

Current value

MaskHorShiftAllowed

“True” or “False”

Turn mask shifting on or off

Current setting

MaskTestEnabled

“True” or “False”

Turn mask testing on or off

Current setting

MaskPolygonSet

“All” or “Center”

Select mask polygons to use
with PDF eyes

Current polygon set

MaskTarget

either “BER Contour” or “SP
Receiver PDF Eye”

Select graph to apply mask to

Current graph

MaskTargetBER

number in range [0,1]

Set target BER

Current value

MaskTargetHitRatio

number in range [0,1]

Set target hit ratio

Current value

MaskTargetMaskMargin

number in range [-99,+100],
not necessarily an integer

Set target mask margin

Current value

MaskTestType

“PassFail”, “MaskMargin” or
“HitRatio”

Select type of mask test

Current mask test

NumericMode

0 – Hidden
1 – Summary
2 – Full display

Sets the state of the numeric
panel

Current Value

OptimizeReceiver

True | False

Sets whether the receiver
optimizer should compute the
optimum decision points

Current Value

OptimizeToCommonPhase

True | False

Sets whether the optimizer
restricts all optimized
decision points to have
the same phase, according
to the OIF-CEI standard
specification

Current Value

80SJNB Printable Application Help

Remote control

Variable name arguments and queries

Variable name

Value

Function

Query form returns

OptimizeToCommonPhaseIEEE

True | False

Sets the optimizer sampling
phase according to the IEEE
standards

Current Value

PatternLength

Any integer value between 2
and 100,000

Sets or returns the data
pattern length in bits

Current value

Indicates whether the data
was acquired with a phase
reference unit active or not
for both acquired and recalled
data

True, False

PhaseReferenceEnabled

PhaseReferenceFrequency

Any valid phase reference
frequency as defined by the
selected phase reference
source module

Sets or returns the phase
reference frequency

Current value

PhaseReferenceSource

{C1C2 -or- C1_C2,
C3C4 -or- C3_C4,
C5C6 -or- C5_C6,
C7C8 -or- C7_C8}

Sets or returns the phase
reference source module

Current value

PrintToFile

path\file

Print all result tabs and
selected plots to a pdf file

“Run” when busy, “Done” or
“Error” when complete
Wait for Done or Error before
proceeding

RecallDataFilename

<file name > 1

Specifies the name of the file
when recalling a saved data
file

RecallFilename

<file name > 1

Sets the name of the file
when recalling a setup

RiseFallHigh

Integer from 1 to 99

Set percentage defining the
high reference level

Current value

RiseFallLow

Integer from 1 to 99

Set percentage defining the
low reference level

Current value

SamplesPerBit

Integer 100 or 40

Sets the number of samples
per unit interval to be
acquired. Default is 100

Current value

SamplingPhase
SamplingPhase1
SamplingPhase2

Any valid floating point
value between –0.5 and
+0.5 inclusive

Sets or returns the normalized
sampling point value of eye 0
(NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2

Current value as set by user;
actual value used will differ if
the Optimizer is both enabled
and successful; see PI query
SamplingPhaseEff

SamplingPhaseAbs
SamplingPhaseAbs1
SamplingPhaseAbs2

Any valid floating point value

Sets or returns the absolute
sampling point value of eye 0
(NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2

Current value as set by user;
actual value used will differ if
the Optimizer is both enabled
and successful; see PI query
SamplingPhaseEff
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Variable name

Value

Function

Query form returns

SamplingPhaseUnits

{Absolute, Normalized}

Sets or returns the desired
sampling point value to use.
If the units are set to Absolute,
the SamplingPhaseAbs value
is used. If the units are set
to Normalized, the sampling
point is calculated based on
waveform data according
to the SamplingPhase
normalized value.

Current value

SaveDataFilename

<file name > 1

Sets the file name used when
saving data files

SaveFilename

<file name > 1

Sets the file name used when
saving setup files

SaveRecallData 3

{Save, Recall}

Save saves the acquired
data to the file name
specified by the command
SaveDataFilename
Recall recalls the acquired
data from the file name
specified by the command
RecallDataFilename

Done, Error
Wait for Done or Error before
proceeding

ScopeSettingRecall

{True | False}

Sets or returns the option of
recalling scope setup stored
when starting the application

Current value

SequencerMode

{SingleSequence, FreeRun}

Sets the sequencer mode
Startup default is Free Run

Sequencer mode

SequencerState 3

{Run | Pause | Stop}

Sets or returns the
Measurement Sequencing
or the Stop Sequencing
command

Sequencer state

Setup 3

{Recall | Save | Default}

Performs the
Save/Recall/Default setup
action

Current value or Done, Error
Wait for Done or Error before
proceeding

SpCompute 2

{Run}

Recomputes results with the
latest Signal Path definition
on the acquired data

Current value or Done, Error
Wait for Done or Error before
proceeding

SSC

{True | False}

Selects whether SSC is
present in the signal
Setting to True requires a
phase reference module to
be installed and configured

Current value
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Variable name

Value

Function

Query form returns

StopOnCondition

{Never | AcqCycle
| UncorrCount |
TotalPopulation}

Sets or returns the selected
Stop on Condition when in
Free Run

Current value

SymbolRate 5

Any valid positive floating
point value

Sets the symbol rate in baud

Current value

TargetBWforBWE

Any valid positive floating
point value

Sets the 3 dB frequency for
the BWE filter to be created

Current value

TDECQhistoWidth

Positive integer number
range 0 to 10% of Unit
Interval Default is 4%

Sets or returns the histogram
width on which the TDECQ
computation is performed

Current value

TDECQscopeNoise

Positive floating point number
Default is 4e-6

Sets or returns the user
specified scope noise

Current value

TimeUnits

{S | UI}

Sets or returns the units for
the time scale

S, UI

TotalPopCount

Positive integer number

Sets or returns the total
sample count

Current value

UncorrCount

Positive integer number

Sets or returns the
uncorrelated sample count

Current value

UseBWE

{True | False}

Apply a bandwidth
enhancement filter on the
acquired waveform

True or False

Returns the version number
of the installed 80SJNB
application

Current version number

Sets or returns the
wavelength of the sources

Current value

Version (Query only)

WLength

Any valid wavelength as
defined by the selected
source module

xxx

1
2
3
4
5

<file name > is a string of 1 to 40 characters that are valid for file names according to the Windows file system standards.
After running the default setup command, this argument is not initialized and a query returns an empty string "".
Precede this command by a delay of at least 400 ms.
See Valid graph name strings for GraphSelection<n> command (see page 117).
SymbolRate is identical to DataRate when DataRate is used to specify a number.

Valid graph name strings for GraphSelection<n> command
The following strings are the valid graph names for use with the PI commands GraphSelection1,
GraphSelection2, GraphSelection3 and GraphSelection4. The names must be exact including spacing
and, like all PI command arguments, enclosed within double quotes.
Example: VARIABLE:VALUE "GraphSelection2","RJ*PJ Spectrum"
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Jitter Graph names
DDJ vs Bit
DDPWS vs Bit
RJ*PJ PDF
RJ PDF
PJ PDF
DJ PDF
DDJ PDF
TJ PDF
RJ*PJ Spectrum
DDJ Spectrum
BER H Bathtub
Q H Bathtub

Noise Graph names
DDN vs Bit
RN*PN PDF
RN PDF
PN PDF
DN PDF
DDN PDF
TN PDF
RN*PN Spectrum
DDN Spectrum
BER V Bathtub
Q V Bathtub

Eye Graph names
Correlated Eye
BER Eye
Q Eye
BER Contour
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PDF Eye Graph names
SP In PDF Eye
SP Filter PDF Eye
SP Channel PDF Eye
SP Receiver PDF Eye

Patterns Graph names
SP In
SP Filter
SP Channel
SP Equalizer

SSC Graph names
SSC Profile

Variable:Value results queries
These values, when used with the Variable:Value command, return the results for the individual
measurement results. These are query only variable
Programming Examples (see page 125)
Variable value name

Function

AOP

Returns the Average Optical Power

Application

Returns the application name (80SJNB or 80SJARB)

BUJDD
BUJDD1
BUJDD2

Returns the Bounded Uncorrelated Jitter measurement of eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

BUNDD
BUNDD1
BUNDD2

Returns the Bounded Uncorrelated noise measurement of eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

CenterDeviation
CenterDeviation1
CenterDeviation2

Returns the phase deviation of eye relative to sampling phase of eye 1 in picoseconds.
For PAM measurements only.

DCD
DCD1
DCD2

Returns the Duty Cycle Distortion measurement of eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.
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Variable value name

Function

DecisionThresholdEff
DecisionThresholdEff1
DecisionThresholdEff2

Returns the effective value of the decision threshold, either the value entered by the
user or the value computed by the Optimizer, depending on whether the Optimizer
is both enabled and successful.

DDJ
DDJ1
DDJ2

Returns the Data Dependent Jitter measurement of eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

DDN
DDN_1
DDN_2

Returns the Data Dependent Noise measurement of eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

DDN0
DDN0_1
DDN0_2

Returns the Data Dependent Noise on logical level 0 value of eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

DDN1
DDN1_1
DDN1_2

Returns the Data Dependent Noise on logical level 1 value of eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

DDPWS
DDPWS1
DDPWS2

Returns the measured Data Dependent Pulse Width Shrinkage measurement of eye 0
(NRZ eye or bottom eye for PAM) or PAM eyes 1 or 2.

DJ
DJ1
DJ2

Returns the measured deterministic jitter value of eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

DJDD
DJDD1
DJDD2

Returns the Deterministic Jitter computed in the Dual Dirac model for eye 0 (NRZ eye or
bottom eye for PAM) or PAM eyes 1 or 2.

DN
DN1
DN2

Returns the measured deterministic noise measurement of eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

EA
EA1
EA2

Returns the amplitude of the eye computed as the mean-to-mean of logical 1 and logical
0 bit levels sampled at the user defined Sampling Phase, for eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

EffSymbolLevel1

Returns the effective symbol level 1 value. For PAM measurements.

EffSymbolLevel2

Returns the effective symbol level 2 value. For PAM measurements.

EOH
EOH1
EOH2

Returns the Horizontal Eye Opening at user-specified BER, for eye 0 (NRZ eye or
bottom eye for PAM) or PAM eyes 1 or 2.

EOV
EOV1
EOV2

Returns the Eye Opening at user-specified BER, for eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

ER

Returns the Extinction Ratio for NRZ or PAM4 signals.

Jx
Jx1
Jx2

Returns the Total jitter at the BER given by JxBER, for PAM eyes 0, 1, or 2.
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Variable value name

Function

Jy
Jy1
Jy2

Returns the Total jitter at the BER given by JyBER, for PAM eyes 0, 1, or 2.

Level0

Returns the voltage of the lowest signal level. For PAM measurements.

Level1

Returns the voltage of the second signal level. For PAM measurements.

Level2

Returns the voltage of the third signal level. For PAM measurements.

Level3

Returns the voltage of the highest signal level. For PAM measurements.

LevelDeviation

Returns the level deviation. For PAM measurements.

LevelMismatch

Returns the level separation mismatch ratio. For PAM measurements.

LevelPkPk0

Returns the peak-to-peak range of the measurements of Level0. For PAM
measurements.

LevelPkPk1

Returns the peak-to-peak range of the measurements of Level1. For PAM
measurements.

LevelPkPk2

Returns the peak-to-peak range of the measurements of Level2. For PAM
measurements.

LevelPkPk3

Returns the peak-to-peak range of the measurements of Level3. For PAM
measurements.

LevelStdDev0

Returns the standard deviation of the measurements of Level0. For PAM measurements.

LevelStdDev1

Returns the standard deviation of the measurements of Level1. For PAM measurements.

LevelStdDev2

Returns the standard deviation of the measurements of Level2. For PAM measurements.

LevelStdDev3

Returns the standard deviation of the measurements of Level3. For PAM measurements.

LevelThickness

Returns the level thickness. For PAM measurements.

LevelTimeDeviation

Returns the global measure of the level time deviation. For PAM measurements.

MaskBERLimit

Returns a number in the range 1e-24 to 1.0.

MaskBERMaskMargin

Returns the BER mask margin in the range -99.0 to +100.0.

MaskCenterPolygon

Returns the hit ratio in the range 0-1.

MaskDataDefined

Returns (“True” or “False”) whether the mask test is defined.

MaskGlobalHitRatio

Returns the global hit ratio in the range 0-1.

MaskGlobalMaskMargin

Returns the mask margin in the range -99.0 to +100.0.

MaskHorizontalShift

Returns the mask shift in seconds.

MaskModulation

Returns “NRZ” or “PAM”.

MaskOvershootPolygon

Returns the hit ratio in the range 0-1.

MaskPassFailStatus

Returns “Pass”, “Fail” or “N/A”

MaskStandardName

Returns the standard for which the mask was defined.

MaskUndershootPolygon

Returns the hit ratio in the range 0-1.

MinSignalLevel

Returns the minimum signal level. For PAM measurements.
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Variable value name

Function

NoiseRMSHigh
NoiseRMSHigh1
NoiseRMSHigh2

Returns the random noise measurement on level high for NRZ or PAM4 lower eye
0 (NoiseRMSHigh), PAM4 middle eye 1 (NoiseRMSHigh1), or PAM4 upper eye 2
(NoiseRMSHigh2)

NoiseRMSLow
NoiseRMSLow1
NoiseRMSLow2

Returns the random noise measurement on level low for NRZ or PAM4 lower eye
0 (NoiseRMSLow), PAM4 middle eye 1 (NoiseRMSLow1), or PAM4 upper eye 2
(NoiseRMSLow2)

NPJDD
NPJDD1
NPJDD2

Returns the non periodic jitter measurement for eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

NPNDD
NPNDD1
NPNDD2

Returns the non periodic noise measurement for eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

OMA
OMA1
OMA2

Returns the optical modulation amplitude in watts (for optical signals) for PAM eyes 0, 1,
or 2. OMA is also valid for NRZ.

OMAOuter

Returns the global value of OMA (Optical Modulation Amplitude). For PAM
measurements.

PJ
PJ1
PJ2

Returns the measured Periodic Jitter (peak-to-peak) measurement for eye 0 (NRZ eye
or bottom eye for PAM) or PAM eyes 1 or 2.

PJH
PJH1
PJH2

Returns the Horizontal component of periodic jitter (peak-to-peak) measurement for eye
0 (NRZ eye or bottom eye for PAM) or PAM eyes 1 or 2.

PJV
PJV1
PJV2

Returns the Vertical component of periodic jitter (peak-to-peak) induced by noise
converted to jitter through an average slew rate, for eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

PN
PN1
PN2

Returns the measured periodic noise measurement for eye 0 (NRZ eye or bottom eye
for PAM) or PAM eyes 1 or 2.

PNH
PNH1
PNH2

Returns the Horizontal component of periodic noise (peak-to-peak) induced by jitter
converted to noise through an average slew rate, for eye 0 (NRZ eye or bottom eye for
PAM) or PAM eyes 1 or 2.

PNV
PNV1
PNV2

Returns the Vertical component of periodic noise (peak-to-peak) measurement for eye 0
(NRZ eye or bottom eye for PAM) or PAM eyes 1 or 2.

RiseFallCountAB

Returns the number of transitions from A to B.
For all Rise/Fall queries, A is the number of the starting level while B is the number of
the ending level. A and B are different numbers chosen from {0,1} for NRZ and are
different numbers chosen from {0,1,2,3} for PAM4.

RiseFallCVAB

Returns the Coefficient of Variation of transition times from A to B or -1 if not computable.
For all Rise/Fall queries, A is the number of the starting level while B is the number of
the ending level. A and B are different numbers chosen from {0,1} for NRZ and are
different numbers chosen from {0,1,2,3} for PAM4.
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Variable value name

Function

RiseFallMaxAB

Returns the maximum of transition times from A to B or -1 if not computable.
For all Rise/Fall queries, A is the number of the starting level while B is the number of
the ending level. A and B are different numbers chosen from {0,1} for NRZ and are
different numbers chosen from {0,1,2,3} for PAM4.

RiseFallMeanAB

Returns the mean transition time from A to B or -1 if not computable.
For all Rise/Fall queries, A is the number of the starting level while B is the number of
the ending level. A and B are different numbers chosen from {0,1} for NRZ and are
different numbers chosen from {0,1,2,3} for PAM4.

RiseFallMinAB

Returns the minimum of transition times from A to B or -1 if not computable.
For all Rise/Fall queries, A is the number of the starting level while B is the number of
the ending level. A and B are different numbers chosen from {0,1} for NRZ and are
different numbers chosen from {0,1,2,3} for PAM4.

RiseFallStdDevAB

Returns the standard deviation of transition times from A to B or -1 if not computable.
For all Rise/Fall queries, A is the number of the starting level while B is the number of
the ending level. A and B are different numbers chosen from {0,1} for NRZ and are
different numbers chosen from {0,1,2,3} for PAM4.

RJ
RJ1
RJ2

Returns the measured random jitter (RMS) measurement for eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

RJDD
RJDD1
RJDD2

Returns the Random Jitter computed in the Dual Dirac model measurement for eye 0
(NRZ eye or bottom eye for PAM) or PAM eyes 1 or 2.

RJH
RJH1
RJH2

Returns the Horizontal component of random jitter (RMS) measurement for eye 0 (NRZ
eye or bottom eye for PAM) or PAM eyes 1 or 2.

RJV
RJV1
RJV2

Returns the Vertical component of random jitter induced by noise converted to jitter
through an average slew rate (RMS), for eye 0 (NRZ eye or bottom eye for PAM) or
PAM eyes 1 or 2.

RN
RN1
RN2

Returns the measured Random Noise measurement for eye 0 (NRZ eye or bottom
eye for PAM) or PAM eyes 1 or 2.

RNH
RNH1
RNH2

Returns the Horizontal component of random noise induced by jitter converted to
noise through an average slew rate, for eye 0 (NRZ eye or bottom eye for PAM) or
PAM eyes 1 or 2.

RNV
RNV
RNV2

Returns the Vertical component of random noise measurement for eye 0 (NRZ eye or
bottom eye for PAM) or PAM eyes 1 or 2.

SampleCount

Returns the total sample count acquired and processed while running.

SamplingPhaseEff
SamplingPhaseEff1
SamplingPhaseEff2

Returns the effective value of the sampling phase, either the value entered by the user
or the value computed by the Optimizer, depending on whether the Optimizer is both
enabled and successful.

SSCfreq

Returns the spread spectrum clock modulation frequency.

SSCmag

Returns the spread spectrum clock modulation magnitude.
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Variable value name

Function

TDECQ

Returns the Transmitter and Dispersion Eye Closure for PAM4 signaling.

TimeDeviation

Returns the time deviation.

TJ
TJ1
TJ2

Returns the Total Jitter at user-specified BER measurement for eye 0 (NRZ eye or
bottom eye for PAM) or PAM eyes 1 or 2.

TN
TN1
TN2

Returns the Total Noise at user-specified BER measurement for eye 0 (NRZ eye or
bottom eye for PAM) or PAM eyes 1 or 2.

VerticalEyeClosure

Returns the vertical eye closure. For PAM measurements.

VMA
VMA1
VMA2
MVA2

Returns the voltage modulation amplitude in volts (for electrical signals) for PAM eyes
0,1, or 2. VMA is also valid for NRZ.

VMAOuter

Returns the global value of VMA (Voltage Modulation Amplitude). For PAM
measurements.

xxx
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GPIB commands error codes
Error code

Description

–1

Read error message, no error code available

NOTE. If an error code of –1 is returned, use the Error Message query for error
condition details.
1

The channel does not support bandwidth

2

Phase characterization failed

3

No data to export

4

Not allowed to change setting while sequencing

5

Invalid value

6

Argument cannot be null

7

Value is outside the range of acceptable values

8

Query curve returned no data

9

Unexpected GPIB response

10

No data source selected

11

One or more WfmDBs are on; turn them off to continue

12

Trigger failure, check your configuration

13

The pattern is not synchronized or is too small

14

Cannot export the curve

15

Could not analyze edge

16

Histogram testing is on; turn it off to continue

17

Mask testing is on; turn it off to continue

18

One or more measurements are on; turn them off to continue

19

Waveforms other than 80SJNB signal source are on; turn them off to continue

20

Save setup failed

21

Recall setup failed

22

The channel does not support wavelength

23

Curve has multiple components

24

A Mag View is on; turn it off to continue

25

SSC activation failed; phase reference module required

26

SSC activation failed; setup phase reference module

27

Save data failed

28

Recall data failed

xxx

Programming examples introduction
An example of communicating with the 80SJNB application using VARIABLE:VALUE remote GPIB
commands is to simply start the application by sending the following command:
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APPlication:ACTivate "80SJNB"

A more extensive program example steps you through the following actions:
1. Starting the application.
2. Configuration and setting analysis state variables.
3. Starting and checking the state of the acquisition and processing cycle.
4. Check for errors.
5. Query measurement results.
6. Export data.

Program examples:
Configure and Operate the 80SJNB (see page 126)
Measuring Jitter in Presence of SSC (see page 128)
Compensating for Signal Path Impairments with Equalization (see page 130)

See also:
About the GPIB Program and Guidelines (see page 103)
GPIB Reference Materials (see page 103)
Variable:Value Command (see page 106)
Results Queries (see page 119)

Program example: configure and operate 80SJNB
The following sequence of commands shows the GPIB commands used to configure and operate the
80SJNB jitter analysis application. All commands are sent to the instrument which hosts the programmable
interface for the 80SJNB.
NOTE. The examples presume that you are familiar with designing GPIB programs.
All words within quotes are case sensitive and must be entered exactly as shown, including spaces and
quotes.
1. Send the command to start the 80SJNB application.
APPLICATION:ACTIVATE "80SJNB"

2. Set the signal source channel, data rate, and pattern length to be analyzed.
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VARIABLE:VALUE "DataSource","CH1"
VARIABLE:VALUE "DataRate","10.3125e9"
VARIABLE:VALUE "PatternLength","32767"

3. Set the following variables before starting the analysis. The application updates these values to signal
the application’s analysis state.
VARIABLE:VALUE "DataReady","False"
VARIABLE:VALUE "ErrorCode",""

4. Start the acquisition and processing cycle.
VARIABLE:VALUE "SequencerState","Run"

5. Check the state of the acquisition and processing cycle.
Query the following variables:
VARIABLE:VALUE? "DataReady"
VARIABLE:VALUE? "SequencerState"

Loop until DataReady is True or SequencerState is Stop.
6. Check to see if there were errors.
VARIABLE:VALUE? "ErrorCode"

If the response for ErrorCode is not 0 then an error has occurred. Query
VARIABLE:VALUE? "ErrorMessage"

to retrieve the error message.
7. If the DataReady variable is set to True (queried in step 5), you can query for measurement results.
For example to query the deterministic jitter:
VARIABLE:VALUE? "DJ"

8. You can also export the plot data. The following commands set the format, data to export, file name,
and then exports the data.
VARIABLE:VALUE "ExportFormat","CSV"
VARIABLE:VALUE "ExportType","DJPDF"
VARIABLE:VALUE "ExportFilename","C:\Users\<username>\Documents\
myDJPDF.csv"
VARIABLE:VALUE "ExportCurve","GO"

9. Query the ExportCurve variable to determine when the data export has completed:
VARIABLE:VALUE? "ExportCurve"

The application sets the ExportCurve value to "Done" when the data is exported.
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Program examples:
Measuring Jitter in Presence of SSC (see page 128)
Compensating for Signal Path Impairments with Equalization (see page 130)

Program example: measuring jitter in presence of SSC
The following instruction sequence shows jitter analysis in the presence of SSC and the measurement of
the SSC characteristics.
NOTE. The examples presume that you are familiar with designing GPIB programs.
All words within quotes are case sensitive and must be entered exactly as shown, including spaces and
quotes.
NOTE. The measurement system configuration should include a correctly set up and configured Tektronix
BERTScope CR series instrument (clock recovery instrument, or CRI) that supports SSC.
A Tektronix 82A04 or 82A04B Phase Reference module is required for measuring signals that contain SSC.
1. Send the command to start the 80SJNB application.
APPLICATION:ACTIVATE "80SJNB"

2. Set the signal source channel, data rate, pattern length, and data-to-clock ratio
VARIABLE:VALUE "DataSource","CH1"
VARIABLE:VALUE "DataRate","3e9"
VARIABLE:VALUE "PatternLength","127"

3. Initialize analysis state and error code.
VARIABLE:VALUE "DataReady","False"
VARIABLE:VALUE "ErrorCode",""

4. Tell 80SJNB to look for SSC.
VARIABLE:VALUE “SSC”,”True”

5. Set up the phase reference module source and frequency since it is required for SSC analysis
VARIABLE:VALUE “PhaseReferenceSource”,”C7_C8”
VARIABLE:VALUE “PhaseReferenceFrequency”,”3e9”

6. Set up the BERTScope clock recovery unit that supports SSC. Set clock frequency to 3e9. Refer to the
documentation for the BERTScope for more details.
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The following table lists recommended settings:

Data rate range

Clock recovery
frequency (CRI)

Clock recovery
output rate (CRI)

Recommended
Data:Clock ratio
(JNB)

Phase reference
frequency (JNB)

500 Mbps – 1 Gbps

Data Rate * 4

Standard

1:4

Data Rate * 4

1 Gbps – 2 Gbps

Data Rate * 2

Standard

1:2

Data Rate * 2

2 Gbps – 4 Gbps

Data Rate

Standard

1:1

Data Rate

4 Gbps – 8 Gbps

Data Rate

Subrate (1/2)

2:1

Data Rate/2

8 Gbps – 12.5 Gbps

Data Rate

Subrate (1/4)

4:1

Data Rate/4

xxx

7. Clear the error code to prepare for starting the application.
VARIABLE:VALUE "ErrorCode",""

8. Start the acquisition and processing cycle.
VARIABLE:VALUE "SequencerState","Run"

9. Check the state of the acquisition and processing cycle. Query the following variables:
VARIABLE:VALUE? "DataReady"
VARIABLE:VALUE? "SequencerState"

Loop until DataRead is True or SequencerState is Stop.
10. Check if there were errors:
VARIABLE:VALUE? “ErrorCode”

If the response for ErrorCode is not 0, then an error has occurred. Query:
VARIABLE:VALUE? “ErrorMessage”

11. If the DataReady variable is set to True, and no errors have occurred, you can query for measurement
results.
For example to query the periodic jitter and total jitter:
VARIABLE:VALUE? “PJ”
VARIABLE:VALUE? “TJ”

12. Query for SSC measurements, magnitude and frequency.
VARIABLE:VALUE? “SSCmag”
VARIABLE:VALUE? “SSCfreq”

13. You can also export the SSC profile. The following commands set the format, data to export, file
name, and then export the data.
VARIABLE:VALUE "ExportFormat","CSV"
VARIABLE:VALUE "ExportType"," SSCPROFILE "
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VARIABLE:VALUE "ExportFilename","C:\Users\<username>\Documents\
mySSCprofile.csv"
VARIABLE:VALUE "ExportCurve","GO"

14. Query the ExportCurve variable to determine when the data export has completed.
VARIABLE:VALUE? "ExportCurve"

The application sets the ExportCurve value to "Done" when the data is exported.

Program examples:
Configure and Operate the 80SJNB (see page 126)
Compensating for Signal Path Impairments with Equalization (see page 130)

Program example: compensating for signal path impairments with
equalization
The following programming example shows a sequence of commands that configures the Signal Path with
a Channel emulator that causes severe ISI. Then an Equalizer is inserted and configured to compensate
for the effects of the ISI and assess the results of equalization by measuring data dependent jitter and
vertical eye opening.
NOTE. The examples presume that you are familiar with designing GPIB programs.
All words within quotes are case sensitive and must be entered exactly as shown, including spaces and
quotes.
NOTE. The 80SJNB Advanced option must be enabled. The S-parameter file is available from examples,
Sdd21.s1p, located in My Documents.
1. Send the command to start the 80SJNB application.
APPLICATION:ACTIVATE "80SJNB"

2. Set the signal source channel, data rate, pattern length, and data-to-clock ratio.
VARIABLE:VALUE "DataSource","CH1"
VARIABLE:VALUE "DataRate","9.95328e9"
VARIABLE:VALUE "PatternLength","127"

3. Initialize the analysis state and error code.
VARIABLE:VALUE "DataReady","False"
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VARIABLE:VALUE "ErrorCode",""

4. Start the acquisition and processing cycle.
VARIABLE:VALUE “SequencerState”,”Run”

5. Check the state of the acquisition and processing cycle.
Query the following variables:
VARIABLE:VALUE? "DataReady"
VARIABLE:VALUE? "SequencerState"

Loop until DataRead is True or SequencerState is Stop.
6. Check if there were errors.
VARIABLE:VALUE? “ErrorCode”

If the response for ErrorCode is not 0, then an error has occurred. Query:
VARIABLE:VALUE? “ErrorMessage”

7. If the DataReady variable is set to True and no error has occurred, you can query for measurement
results. Query the data dependent jitter and vertical eye opening:
VARIABLE:VALUE? “DDJ”
VARIABLE:VALUE? “EOV”

8. Select an S-parameter file from the examples provided, and insert the Channel emulator into the
Signal Path.
VARIABLE:VALUE “CeDomain”,”Frequency”
VARIABLE:VALUE “CeFdSParametersFile”,” C:\Users\<username>\
Documents\Sdd21.s1p”
VARIABLE:VALUE “CeActive”,”True”

9. Recompute the Signal Path and measure DDJ and vertical eye opening again.
VARIABLE:VALUE “SpCompute”,”Run”

Wait and query the recomputation state for completion. When completed, SpCompute query will
return Done, unless an error is encountered, in which case state will return Error.
VARIABLE:VALUE? “SpCompute”
VARIABLE:VALUE? “DDJ”
VARIABLE:VALUE? “EOV”

NOTE. Note the values of DDJ and EOV.
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10. Compute an optimal set of tap coefficients for a specified number of FFE and DFE taps by running
Autoset Taps.
VARIABLE:VALUE “EqFFETaps”,”20”
VARIABLE:VALUE “EqDFETaps”,”10”
VARIABLE:VALUE “EqAutosetTaps”,”Run”

Test for completion by querying the state of autoset. It will return Run before completion, then Done
or Error. If data is not recognized as a PRBS pattern, an error condition is returned.
VARIABLE:VALUE? “EqAutosetTaps”

11. Save the taps in a file.
VARIABLE:VALUE “EqTapsFilename”,”C:\Users\<user name>\Documents\myTaps.tap”
VARIABLE:VALUE “EqSaveTaps”,”Run”

Check for completion by querying:
VARIABLE:VALUE? “EqSaveTaps”

12. Insert the Equalizer in the Signal Path with the newly configured equalization taps.
VARIABLE:VALUE “EqActive”,”True”

13. Recompute the Signal Path again with the Equalizer inserted.
VARIABLE:VALUE “SpCompute”,”Run”

Wait and query the recomputation state for completion. When completed, query SpCompute until it is
not Run. Then check to see if the result is Done or Error.
VARIABLE:VALUE? “SpCompute”

14. If SpCompute query is Done, ask for measurement results.
VARIABLE:VALUE? “DDJ”
VARIABLE:VALUE? “EOV”

NOTE. Record the values of DDJ and EOV and compare with the previous two sets, looking for the
effects of the Channel and the Equalizer.

Program examples:
Configure and Operate the 80SJNB (see page 126)
Measuring Jitter in Presence of SSC (see page 128)
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About measurement algorithms
Tektronix has developed a white paper detailing the algorithms used by the 80SJNB application to make
the measurements. To download the document:
1. Go to the Tektronix website www.tek.com .
2. Enter “Jitter and Noise Analysis” in the Downloads Enter Model Number field.
3. Click GO.

Test methodology
The application performs the measurement according to the following steps:
1. Configures the oscilloscope and jitter application according to the Configuration settings and Analysis
settings.
2. Performs an Autoset.
3. Scans part of the pattern.
4. Analyzes the edge.
5. Acquires the jitter data.
6. Acquires the noise data.
7. Scans the full pattern.
8. Analyzes the acquired data.
9. Displays the results as statistics. You can also log the results or data points to a .csv file.
10. Displays the plots if selected.
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Correlation to real-time oscilloscope jitter measurements
Recent correlation studies are available upon request. Please contact your Tektronix Customer Support
representative for more information. Jitter measurement and timing analysis information is available
at www.tek.com (enter jitter in the Enter Model Number field, and select Application Notes as the
document type).
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InterX.m license
InterX.m is licensed from its author (NS) and under the BSD license:
Copyright (c) 2009, NS
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

PDFSharp license
PDFSharp is licensed from Empira Software GmbH under the MIT License:
Copyright (c) 2005-2014 empira Software GmbH, Troisdorf (Germany)
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
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LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.
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